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Safety Information 

 There is a danger of a new battery exploding if it is incorrectly 
installed. Replace the battery pack only with the same or 
equivalent type recommended by the manufacturer. Do not 
dispose of the battery along with household waste. Contact your 
local waste disposal agency for the address of the nearest battery 
deposit site. 

This product also uses a lithium coin cell battery. The lithium coin cell battery is a long-life 
battery, and it is very possible that you will never need to replace it. However, should you 
need to replace it, consult your service documentation. Do not dispose of the battery along 
with household waste. Contact your local waste disposal agency for the address of the 
nearest battery deposit site. 

Following are the safety agency certifications that the GigaStorATX controller is designed to 
meet when installed and operated in an appropriately certified enclosure: 

 UL 60950 

 CSA 22.2, No. 60950 

 EN 60950 

 IEC 60950 

Compliance Information 

Meets EMI and Safety preliminary testing. Final testing will be determined upon complete 
solution compliance testing. 

Notice of Export Controls 

Export of technical data contained in this document may require an export license from the 
United States government. Please contact GIGA-BYTE Technology CO., LTD. for any export 
compliance questions. 

Document Revision Level 

Revision Date Description 

GSATX10F01 November 2005 Initial Release 

GSATX11F01 March 2006 Revision 1, supersedes and replaces GSATX10F01 
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Changes in this Revision 

 Section 2.6: Revised the GigaStorATX shutdown procedure. 

 Section 3.1: Made minor changes to the Overview section. 

 Section 4.1.2: Revised the procedure for creating volumes manually. 

 Section 5.2.1.2: Revised the IP addresses used as examples in this procedure. 

 Section 6.9: Revised the procedure for setting the spare count. 
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Preface 

This User Functional Guide is intended for storage managers and administrators responsible 
for configuring and maintaining the GigaStorATX. 

This User Functional Guide assumes that the user: 

 Is computer literate. 

 Is familiar with operating Web browser software and working in a windowing 
environment. 

 Has a basic understanding of storage products and concepts. 

Typographic Conventions 

The following conventions and icons are used in this User Functional Guide. 

Notes 

Notes provide information that deserves special attention. Notes are preceded by the 
following icon: 

 

 

Cautions 

Cautions contain information which, if not followed, can cause damage to the GigaStorATX. 
Cautions are preceded by the following icon: 

 

 

Warnings 

Warnings contain information which, if not followed, can cause damage to the GigaStorATX 
and to the person installing it. Warnings are preceded by the following icon: 
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Contact Information 

For more information about the GigaStorATX or GIGA-BYTE Technology CO., LTD., please 
contact us using  the following methods: 

 Web site: Our Web site contains valuable information about our products. We encourage 
you to visit us at http://www.gigabyte.com.tw. 
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Chapter 1 Introduction 

This chapter provides an introduction to the GigaStorATX management console. 

Topics in this chapter include: 

 Section 1.1, GigaStorATX Management Console on page 16 

 Section 1.2, Configuration Roadmap on page 16 
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1.1 GigaStorATX Management Console 

The GigaStorATX management console is a Java-based, Web-enabled application that 
provides comprehensive and unified storage network management capabilities of the 
GigaStorATX Storage Controller.  

The GigaStorATX management console is integrated with the GigaStorATX Storage Controller, 
allowing you to manage GigaStorATX storage using today’s popular Web browsers, without 
having to install additional drivers or software. The GigaStorATX management console also 
provides an intuitive interface that lets you create storage pools, allocate storage resources 
to servers, and direct storage network traffic using Virtual LAN (VLAN) zones simply by 
pointing and clicking your mouse. 

1.2 Configuration Roadmap 

The following steps summarize the procedures for configuring and managing storage on the 
GigaStorATX. For more information about a step, refer to the section show in the step. 

1. Make sure the GigaStorATX Storage Controller is installed, cabled, and powered on. 
Refer to Section 2.1. 

2. Log in to the GigaStorATX management console. Refer to Section 2.2. 

3. If necessary, change the default Internet Protocol (IP) address and reboot the console. 
Refer to Section 2.2. 

4. Create one or more volumes on the disks attached to the GigaStorATX Storage Controller. 
Refer to Section 4.1. 

5. Create one or more iSCSI initiator nodes. Refer to Section 5.1. 

6. Create one or more network portals. Refer to Section 5.2. 

7. Create one or more iSCSI target nodes. Refer to Section 5. 

8. Perform an iSCSI log on to the iSCSI initiator. Refer to Section 5.5. 

9. At the end of your session, shut down the GigaStorATX management console and Storage 
Controller. Refer to Section 2.5. 
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Chapter 2 Getting Started 

This chapter describes the initial setup procedure for the GigaStorATX.  

Topics in this chapter include: 

 Section 2.1, Setting Up the GigaStorATX on page 18 

 Section 2.2, Launching the GigaStorATX Management Console on page 19 

 Section 2.3, Defining User Accounts on page 21 

 Section 2.4, Understanding the Main Screen on page 21 

 Section 2.5, Changing the Default IP Address on page 27 

 Section 2.6, Shutting Down the GigaStorATX Management Console on page 28 

 Section 2.7, Shutting Down the GigaStorATX on page 29 
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2.1 Setting Up the GigaStorATX 

Before using the GigaStorATX management console, verify that the GigaStorATX is properly 
installed, cabled, and powered on. This includes: 

 Installing the GigaStorATX in an enclosure. 

 Installing the system and buffer memory DIMMs. 

 Connecting to the Storage Area Network (SAN). 

 Attaching one or more SATA drives. 

 Connecting the battery pack. 

 Setting the GigaStorATX headers and jumpers. 

 Connecting a personal computer (PC) with an installed Network Interface Card (NIC) to 
the GigaStorATX management port (J8). 

 

 

If this PC will also act as the iSCSI initiator, it must have two NICs installed. 

 Connecting the battery pack connects to the 3-pin locking connector (J35). 

 Connecting the GigaStorATX to a wall outlet that conforms to the installed power supply. 

 

 

For more information about performing these steps, refer to the 
GigaStorATX Beta Enclosure Guide. 
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2.2 Launching the GigaStorATX Management Console 

To launch the GigaStorATX Management Console: 

1. Power-up the GigaStorATX Storage Controller. 

2. Once the GigaStorATX is powered-up, start a Web browser, such as Microsoft® Internet 
Explorer, on the PC. 

3. In the browser’s address bar, type the following default IP address for the GigaStorATX 
management console and press the Enter key: 

192.168.1.1 

The GigaStorATX console management Log in screen appears (see Figure 2.1). 

 

Figure 2.1. GigaStorATX Log in Screen 

 

 

If the GigaStorATX management console does not start automatically return 
to the HTTP://192.168.1.1 browser window and click on the click here 
link. If you are having problems starting the GigaStorATX Management 
Console you may need to install and or reinstall Java and/or Java Web start 
by clicking the lower click here link. 

 

 

The IP address on your PC's NIC must be on the same IP subnetwork 
(192.168.1.x) as the management port. 

4. Enter your username and password in the appropriate text boxes. The first time you log 
in, you must use the default username (admin) and password (admin). 

 

 

If desired, you can click the More button to view the IP address you will be 
connecting to and change it if necessary. 
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5. Click the OK button. A screen appears with a progress bar as the connection is being 
made to the GigaStorATX. Once the connection is made, the main screen appears (see 
Figure 2.2). 

 

Figure 2.2. GigaStorATX Management Console Main Screen 
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2.3 Defining User Accounts 

Before a user can access the GigaStorATX management console, a user account must be set 
up for the user. When you set up a user account, you can specify whether the user can 
manage storage and/or add users and define their permissions. For more information, refer 
to Section 6.1. 

2.4 Understanding the Main Screen 

Figure 2.3 shows the areas of the GigaStorATX management console main screen. The 
following section describes the areas indicated in Figure 2.3. 

 

 

Figure 2.3. Parts of the GigaStorATX Management Console Main Screen  

Resources 
Pane 

Main Display 
Area 

Menu/Tool Bar 
Area 

Footer  
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2.4.1 Menu / Tool Bar Area  

The Menu/Tool Bar Area appears at the top of the GigaStorATX management console window. 
This area contains the following components (see Figure 2.4): 

 Title bar. The title bar shows the name of the application. On the right side of the title 
bar are the standard Windows buttons for minimizing, maximizing, and closing the 
GigaStorATX management console application. 

 Menu bar. The menu bar is located below the title bar. The menu bar contains the 
menus you can select to perform a range of storage tasks. The GigaStorATX management 
console provides the following menus: 

– File 

– View 

– Storage  

– Network 

– Help 

Depending on the activity you are performing, some menus may be gray and unavailable. 
For a description of the options in each menu, refer to Appendix A. 

 Tool bar. The tool bar is located below the menu bar. The tool bar provides convenient 
shortcuts for menu options and other operations. The tools that appear on the tool bar 
vary, depending on the task you are performing. 

 

Figure 2.4. Menu/Tool Bar Area 

 

Title Bar 

Menu Bar 

Tool Bar 
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2.4.2 Resources Pane  

The resources pane appears along the left side of the GigaStorATX management console 
window (see Figure 2.5). This pane can show either physical resources (such as drives and 
Ethernet connections) or logical resources (such as iSCSI initiator, iSCSI target, and LAG 
resources), depending on whether the Physical Resources tab or Logical Resources tab is 
selected. 

These tabs work the same way Windows Explorer works. A plus sign (+) next to an item, for 
example, means that the item contains subitems. To expand the item and see the subitems, 
either double-click the item or click the plus sign next to it. When an item is expanded, a 
minus sign (-) replaces the plus sign next to the item. Click the minus sign to collapse the 
item. 

In this Guide, you will see references to the “active tab.” The active tab is the tab that is on 
top (in front) of the other tab. Only one tab can be active at a time. To switch between the 
Physical Resources tab and the Logical Resources tab, click the tab name. 

     

Example of Physical Resources Tab      Example of Logical Resources Tab 

Figure 2.5. Resources Pane 
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2.4.2.1 Physical Resources Tab 

The Physical Resources tab contains the following entities: 

 The GigaStorATX Storage Controller ( ). 

 The physical drives attached to the GigaStorATX Storage Controller ( ). 

 The Ethernet ports on the GigaStorATX Storage Controller ( ). To enhance viewing, the 
port icons are color coded (black = port is offline, green = port is online). 

2.4.2.2 Logical Resources Tab 

The Logical Resources tab contains the following entities: 

 Unusable Collection ( ). Shows drives that have been pulled out of the GigaStorATX 
Storage Controller. Initializing a drive from this location moves the drive to Available 
Pool, where it is rebuilt automatically. 

 Blade A Base Pool ( ). Shows the volumes ( ) and drives ( ) that have been 
created. 

 Available Pool ( ). Shows the available drives ( ) that can be added to the storage 
pool. The first time the system starts, all drives appear in the Available Pool. 

 Target Resources. Shows the network entities ( ) and Link Aggregation Groups (LAGs) 
( ) that have been created. 

 Initiator Resources. Shows the iSCSI initiators ( ) that have been created. 

2.4.3 Main Display Area  

Some items in the Physical Resources and Logical Resources tabs have storage or system 
information associated with them. When you click such an item, the storage or system 
information is displayed in one or more “tabbed” screens in the main display area. The 
tabbed screens resemble index cards. If you click the top GigaStorATX item in the left pane 
of either the Physical Resources tab, for example, four tabs appear in the main display area 
(see Figure 2.6). You can then click the tab to view the information on it. 

For more information about the screens that can appear in the main display area, refer to 
Chapter 7. 
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Figure 2.6. Main Display Area 

 

Figure 2.7. Example of the Main Display Area Showing Blade A Base Pool Information 
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2.4.4 Footer  

The footer appears at the bottom of the GigaStorATX management console window. The 
footer shows status information when appropriate. If you select Blade A Base Pool in the 
Logical Resources tab, for example, the words Blade A Base Pool appear in the footer (see 
Figure 2.8). 

 

Figure 2.8. Example of Message in the Footer 

…displays the 
selection in the 
Footer here 

Selecting Blade 
A Base Pool 
here… 
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2.5 Changing the Default IP Address 

The GigaStorATX management console comes with the following default IP address: 

192.168.1.1 

If you are using a different subnet, use the following procedure to change the IP address. As 
part of this procedure, you can also change the subnet mask, hostname, and gateway 
settings. If you change these settings, you must restart the GigaStorATX Storage Controller 
for the new settings to take effect. 

1. Click the GigaStorATX icon at the top of the Physical Resources tab. 

2. Perform one of the following steps: 

– On the File menu, click Configure Out of Band Port. 

– Right-click and click Configure Out of Band Port.  

 

Either step displays the Configure Out of Band Port dialog box, with the current settings 
shown (see Figure 2.9). 

 

Figure 2.9. Configure Out of Band Port Dialog Box 
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3. Complete the fields in the dialog box: 

– IP address after restart. Enter an available IP address that will take effect after the 
GigaStorATX. 

– Subnet Mask after restart. Enter the subnet mask that will take effect after the 
GigaStorATX. 

– Host name after restart. The GigaStorATX is assigned a default host name. If 
desired, you can change this name to one that is meaningful to you. 

– Gateway after restart. Enter the gateway that will take effect after the 
GigaStorATX. 

 

 

For convenience, the current settings appear below the fields where you 
enter the new settings. 

It is important for you to remember the new IP address, as you will need it 
for subsequent logins to the GigaStorATX management console. We 
recommend that you write the IP address on a piece of paper and store it in 
a safe place in case you need to refer to it in the future. 

4. A message is displayed that the GigaStorATX management console will now exit. Click 
OK to remove this message. 

5. A second message is displayed that the GigaStorATX has been shutdown. Click OK to 
remove this message. 

6. On the File menu, click Restart. When the confirmation prompt “Do you want to restart 
the system?” appears, click Yes. 

7. Wait for the GigaStorATX Storage Controller to become ready. 

8. After the GigaStorATX has become ready and reboot is complete, launch the browser, 
enter the IP address you saved from step 2, and click Go on the browser.  The Login 
Screen initializes and the User Name and Password must be re-entered. 

2.6 Shutting Down the GigaStorATX Management Console 

To shut down the GigaStorATX management console, use the following procedure. 

1. Click the Physical Resources tab. 

2. Perform one of the following steps: 

– On the File menu, click Exit. 

– Click the Close control on the title bar. 
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2.7 Shutting Down the GigaStorATX 

At the end of your session, use the following procedure to shut down the GigaStorATX 
management console. When you shut down, the GigaStorATX Storage Controller powers off 
automatically. 

1. Log off from all initiators. 

2. Click the GigaStorATX icon at the top of the Physical Resources tab. 

3. Perform one of the following steps: 

– On the File menu, click System Shutdown. 

– Right-click and click System Shutdown.  

 

Either step displays a message that asks whether you are sure you want to shut down the 
system. 

4. Click Yes to shut down the system (or click No to keep the system running). If you 
clicked Yes, your management console session ends and the GigaStorATX Storage 
Controller is powered off. 
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Chapter 3 Understanding Terminology and Concepts 

This chapter provides a background on managing virtual storage and explains key terms and 
concepts associated with virtual storage. 

Topics in this chapter include: 

 Section 3.1, Overview on page 32 

 Section 3.2, Storage Pools and Drives on page 33 

 Section 3.3, Volumes on page 33 

 Section 3.4, Spare Count on page 36 

 Section 3.5, Tasks on page 36 
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3.1 Overview 

The purpose of the GigaStorATX is to virtualize disk storage for use by a customer’s host 
computers (servers). At its front end, the GigaStorATX uses the iSCSI protocol over Ethernet 
to connect to the customer’s servers. At its back end, the GigaStorATX connects to a bank of 
Serial ATA (SATA) disk drives. 

The GigaStorATX performs its virtualization task by presenting volumes that the servers see 
as disks or drives, depending on the server operating system’s terminology. Volumes are 
created by organizing blocks of storage from the SATA disk drives. 

iSCSI is an end-to-end storage block protocol that makes it possible to transfer storage data 
reliably over any IP-based network, including the Internet. The iSCSI drafts and RFCs are 
published by the IETF, but based on the SCSI specifications from the ISO's Technical 
Committee Ten (T10), the ANSI-accredited body responsible for developing and maintaining 
the core SCSI standard. To the committee, iSCSI is another SCSI transport and just as 
officially sanctioned (though technically it's a superset of SCSI, providing additional 
functionality through unique commands and data formats used for secondary services such as 
authentication). 

From the network's perspective, iSCSI is just another service that runs over TCP/IP. It can 
use the same networking stack as other applications, with clients requesting data from 
servers. The main difference is that its function is more specialized. Whereas other Layer 7 
protocols such as SMTP are agnostic toward the technologies used at their endpoints, iSCSI is 
designed as a way to extend an existing storage technology across IP networks.  

For iSCSI purposes, the SCSI protocol is conceptually similar to TCP/IP's client/server 
architecture. Every SCSI link involves a host adapter, called an initiator, and a storage 
device, called a “target.” The customer's server will act as the initiator and the GigaStorATX 
will act as the target. A local SCSI bus usually connects a single initiator to up to seven targets, 
but a SAN allows an unlimited number of each. The initiator's iSCSI stack packs SCSI 
commands and data into IP packets, which are then unpacked by the target for processing as 
if they had originated locally.  

The iSCSI protocol defines two types of iSCSI Nodes:  

 The initiator node 

 The target node 

The iSCSI initiator node consists of a name and a set of properties. The server’s operating 
system provides software to define and configure its iSCSI initiator node. The GigaStorATX 
serves as one or more iSCSI target nodes. Section 5.3 describes how to use the GigaStorATX 
management console to define and configure iSCSI target nodes. Within each iSCSI target 
node, one or more volumes can be accessed, using a Logical Unit Number (LUN), by one or 
more iSCSI initiator Nodes. Each iSCSI target node can have up to 256 LUNs. In the 
GigaStorATX, the LUNs available in one target node are independent from the LUNs in other 
target nodes. 
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The server (iSCSI initiator) “sees” the volumes by using the GigaStorATX’s target node name 
and a LUN. This combination creates a “circuit” between the Server operating system’s “disk 
drive letter” (or Dynamic Volume) and the GigaStorATX  volume. The GigaStorATX is 
designed to allow flexibility by granting specific initiator nodes access to specific target 
nodes. One initiator can be given access to multiple target nodes, with different security 
mechanisms to protect different applications. Access to volumes is controlled by the target 
node’s list of allowed LUNs. 

3.2 Storage Pools and Drives 

Storage space is managed on the GigaStorATX through storage pools. The placement of a 
drive in a storage pool controls the way that drive can be used. There are three types of 
storage pools (refer to Table 3.1). 

Table 3.1. Types of Storage Pools 

Storage Pool Usage 

Available Pool Disk drives available for use, but with no data stored on them at this time. A spare 
drive is normally kept in the available pool, so the drive is available for use should 
any other drive fail. 

Blade A Base Pool Disk drives currently being used to hold Volume data or ready to be used to hold 
volume data. 

Unusable Collection Two types of drives appear in the Unusable Collection:   
 Drives not available for use either because they have already failed and have 

not been removed from the enclosure  
 Drive inserted into the GigaStorATX that were found to be used previously by 

a GigaStor. 

When a new system is installed, all new drives are placed in the available pool. The drives 
remain in the available pool until they are needed for use in a volume or moved by the 
Administrator. 

3.3 Volumes 

A volume is a set of blocks of storage that are organized and presented for use by a 
customer’s server (an iSCSI initiator node). Every volume must be associated with a storage 
pool, which limits the drives that can be used to hold data for that Volume (only drives in 
that pool can be used for this volume). Only the Blade A Base Pool can be used for volumes. 

The iSCSI initiator node sees the volume as a contiguous series of numbered blocks, called 
Virtual Logical Block Numbers (VLBNs), in the same way that it would see the storage space 
on a single disk drive. The GigaStorATX constructs a volume from extents, where each 
extent is a block of storage from a single drive. A volume typically consists of extents from 
several drives. A volume of n blocks is shown in Figure 3.1. 
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Figure 3.1. Internal Structure of a Volume 
 

Volume can be organized in several ways (refer to Table 3.2) 

Table 3.2. Ways to Organize Volumes 
 

Organization Definition Redundant Striped Storage 
Cost 

JBOD One copy of the data is written to the selected 
Extents. 

No No 1x 

Mirror Two copies of all data are written to independent 
Extents. 

Yes No 2x 

Stripe Distributes one copy of the data among several drives 
to improve the speed of access. 

No Yes 1x 

Stripe Mirror Distributes the data among several drives and then 
keeps a mirror copy of the blocks on each drive 

Yes Yes 2x 

Parity Distributes one copy of the data among several drives 
and adds parity blocks spread throughout the volume 
to protect against the loss of any single drive. 

Yes Yes 1x-1.5x 

For organizations that are striped, the data distributed among multiple drives is organized in 
a series of “stripes”. Each stripe consists of a fixed number of blocks on each drive. The 
fixed number of blocks used on each drive is called a “chunk.” This can be viewed as an 
array where each row is a stripe and each column is a drive. The term “Member” is defined 
as the number of columns in this array. The GigaStorATX can allocate the required space 
very flexibly (i.e., an entire member does need to reside on a single drive). Within each 
member, extents can be obtained from as many drives as necessary. 

Organizations that are redundant provide protection against loss of data in the event of a 
failure of any one drive. This adds a storage cost in that some storage will be used for 
redundancy rather than for customer data. Redundancy requires that the volume data be 
stored on separate drives, so that data integrity is maintained in the event of a drive failure. 

For a parity organization, the GigaStorATX distributes the volume into the array described 
for a stripe organization, and reserves one chunk from each stripe to hold the parity 
information. The parity information provides redundancy without having to keep a complete 
copy of the data. If any single drive fails, the parity calculation mechanism can be applied to 
the data on the remaining drives to provide full access (reading and writing) of all data.  
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Further, the parity calculation mechanism can be used to recreate the data with fresh parity 
protection onto a new drive to re-gain redundancy. However, this protection comes at a cost: 
the storage requirement for the volume is increased by one member. For example, if a 10 
GB striped volume was distributed among four members, each member would need 2.5 GB of 
space. To make a parity volume of 10 GB using four members, for instance, each member 
would need 3.33 GB of space: one chunk in each stripe would be used to hold parity. In 
other words, to hold the space for parity in a 4-member volume, the GigaStorATX needs to 
use 1/3 more space than the initiator can access. From another point of view, 1/4 of the 
space used by that volume is not available to the initiator. The 10 GB volume can also be 
created using 2.5 GB members if five members are used. 

As a result, the additional storage cost for a parity volume of four members is 25% (i.e., 25% 
of the space is not user data, but redundancy data). For a 5-member parity volume, the 
additional cost is 20%. 

For a mirror organization, the GigaStorATX divides the volume into two members, each of 
which contains one full copy of the data. Each member must be allocated on separate drives. 
The cost of a mirror volume is that data must be stored twice (i.e., for a volume of size x 
bytes, the GigaStorATX needs 2x bytes, or 100%). 

For a stripe mirror organization, the GigaStorATX distributes volume into members, as in a 
striped organization, and then doubles the number of members to allow for the second data 
copy. As in a mirror organization, the storage cost is double.  

For each volume, the GigaStorATX must determine the organization and the size of the 
volume. For striped organizations, the GigaStorATX must further determine the chunk size, 
and the number of drives across which the data is to be divided. 

There are two way to create a volume in a GigaStorATX: 

 Automatically: The Administrator answers questions about the required redundancy, size, 
and usage characteristics of the volume. The GigaStorATX then determines the 
remaining parameters needed to allocate the storage space and create the volume. 

 Manually: The Administrator selects the organization and all other parameters described 
above and selects the drives that can be used for the volume. The GigaStorATX then 
finds the storage space on the given drives to allocate and create the Volume. 

Disk space is assigned to a volume in extents. The extents that make up a volume can be 
seen on the GigaStorATX Management Console. The extents are organized into members. The 
definition of a member varies with the organization: 

 For a striped organization, a member is defined above. 

 For a mirror organization, there are two members, one for each copy of the data. 

 A stripe mirror organization has a member for each stripe, as defined above, plus a 
second member (for each stripe) to hold the data copy. Therefore, if a stripe mirror 
organization has x stripes, it has 2x members. 
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3.4 Spare Count 

The GigaStor Administrator can designate a spare count, which is a number of drives to be 
kept available in case a drive that holds volume data fails. The spare count default is 0, 
meaning that no drives are reserved. If the spare count was 1 in an enclosure with 12 drives 
installed, 11 drives could be used by the GigaStorATX for automatic volume creation and one 
drive would remain in the available pool. As volumes are created, drives would be moved 
from the available pool into the pool in which the volume is created, up to 11 drives. Should 
any of those drives fail, the 12th drive would become available to be used in any rebuild task 
that requires a drive (the rebuild task is described in Section 3.5). 

3.5 Tasks 

The GigaStorATX can automatically or, at the Administrator’s demand, perform activities 
that take time and consume the controller’s resources. The Administrator can control, to 
some degree, when tasks are performed. Any task can be suspended and resumed by the 
Administrator. Some tasks can be cancelled and some can be scheduled on a recurring, 
periodic interval. All tasks can have their priority changed, which controls the amount of 
resources the GigaStorATX devotes to a task.  

The GigaStorATX can perform the following tasks: 

 Initialize a Volume: Some volume organizations (e.g., parity) require Initialization. The 
Initialization task performs this action. This task can be performed while an initiator is 
accessing (reading and writing) data. An Initialization task can be suspended and 
resumed, but cannot be cancelled. 

 Rebuild: When a drive fails, every redundant volume that occupied space on that drive 
can be rebuilt.  

– For mirror protection, data can be copied from the remaining copy. 

– For parity protection, data can be recreated from the remaining data and parity 
information.  

In either case, when the GigaStorATX finds replacement space on another drive, it 
performs one Rebuild task for each extent that used space on the failed drive. If 
replacement space is not available on the drives in the pool associated with the volume, 
and one or more drives exist in the available pool, a drive is obtained from the available 
pool and automatically moved to the volume’s pool. A Rebuild task can be suspended 
and resumed, but cannot be cancelled. 

 Grow (or Expand) Volume: The Administrator can expand the size of a volume. If the 
volume’s organization requires initialization, the initialization of the new space is 
performed with a Grow task. A Grow task can be suspended and resumed, but cannot be 
deleted. An initiator can access the new space while the Grow task is being performed. 

 Media Scan: The Administrator can scan a non-parity volume for media errors by starting 
a Media Scan task. This task reads every block in the volume to ensure there are no 
errors. If there are errors, this task fixes them if possible. A Media Scan task can be 
cancelled, suspended, and/or resumed by the Administrator. It can also be scheduled for 
a future time and/or at a recurring interval. 



 

 GigaStorATX User Functional Guide 37 

 Parity Scan:  The Administrator can scan a parity volume for errors by starting a Parity 
Scan task. This task reads every block in the volume looking for errors as described for 
Media Scan to ensure that parity is correct. If parity errors are found, this task corrects 
the errors. A Parity Scan task can be cancelled, suspended, and/or resumed by the 
Administrator. It can also be scheduled for a future time and/or at a recurring interval. 
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Chapter 4 Managing Volumes 
 

The first step in creating a storage pool is to create volumes for the amount of storage you 
will need on the drives attached to the GigaStorATX Storage Controller. This chapter 
describes how to create volumes.  

Topics in this chapter include: 

 Section 4.1, Creating a Volume on page 40 

 Section 4.2, Modifying Volume Configuration on page 47 

 Section 4.3, Expanding a Volume on page 47 

 Section 4.4, Deleting Volumes on page 49 

 Section 4.5, Performing a Parity Scan on a Volume on page 50 

 Section 4.6, Performing a Media Scan on a Volume on page 51 
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4.1 Creating a Volume 

Adding volumes defines what volumes are accessible through the target. Using the 
GigaStorATX management console, you can create volumes automatically or manually.  

 The automatic method provides the fastest way to create volumes. This method provides 
a Create Volume Wizard that lets you create a volume step-by-step using a series of 
friendly screens. For more information, refer to Section 4.1.1. 

 The manual method provides greater flexibility than the automatic method, allowing you 
to customize and fine-tune volumes. For more information, refer to Section 4.1.2. 

4.1.1 Creating Volumes Automatically 

To create volumes automatically with the Create Volume Wizard, use the following 
procedure. 

1. In the Logical Resources tab, click Blade A Base Pool. 

2. Perform one of the following steps in the Logical Resources tab: 

– Click the Create Volume button on the toolbar: 

 

– On the Storage menu, click Create Volume. 

– Right-click Blade A Base Pool and click Create Volume: 

 

 
Any of these steps starts the Create Volume Wizard and displays the Select Volume Type 
to Create screen (see Figure 4.1). 
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Figure 4.1. Create Volume Wizard Screen – Select Volume Type to Create Screen 

3. Complete the fields in the screen: 

– Name. Enter the name of the volume you are creating. 

– Size. Enter the size of the volume you are creating. Use the drop-down box to select 
the volume capacity: 
 

B   =  bytes 

KB =  kilobytes 

MB =  megabytes 

GB =  gigabytes 
 TB =  terabytes 

 

 

All volumes must be at least 1 MB in size. 

– Data Redundancy. Select whether the volume will have no data redundancy or 
parity or mirror redundancy. For an explanation of these selections, refer to Chapter 
3. 

4. Click the Next button. The Access and Efficiency Settings screen appears (see Figure 
4.2). 
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Figure 4.2. Create Volume Wizard Screen – Access and Efficiency Settings Screen 

5. Use the slider bars to select the access bandwidth and storage efficiency (if displayed) 
desired for this volume. The values allowed for each ranges from 0-10.  Their meaning, 
and usage is as follows: 

– Access Bandwidth Weight: This setting is a measure of how much bandwidth the 
volume will use (i.e., how much initiator I/O activity can be expected for the 
volume). A large number indicates more I/O. It also means the Administrator wants 
the initiators to achieve fast access to the volume, compared to the other volumes 
stored on the GigaStorATX. A large value causes the GigaStorATX to choose a larger 
number of stripe members. The method used by the GigaStorATX to select the 
organization and number of members is described in Table 4.1. 

 Table 4.1. Volume Organization and Members Based on Redundancy and Access Bandwidth Weight 

Redundancy Access Bandwidth Weight Value 

 0 1 Large Values 

None JBOD organization (1 member) Stripe organization with 2 
members 

Stripe organization with more members 

Mirror Mirror organization (2 members) Stripe Mirror organization with 2 
stripe members 

Stripe Mirror organization with more 
stripe members 

Parity Parity organization with 3 
members 

In combination with the Storage Efficiency Hint, this selects Parity 
organization with more members  

 

 

In the Stripe Mirror organization, there are always two members for each 
stripe member to allow for the duplicate copy of the data. 
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– Storage Efficiency Hint: When Parity is selected for Data Redundancy, this 
additional setting allows the Administrator to further tailor the GigaStorATX’s 
selection of the member count. A large value tells the GigaStorATX that the 
Administrator wants to use disk space more efficiently (i.e., use less space for 
redundancy data). As a result, a large value for this hint requests a larger number of 
members (which costs less space for parity overhead). 

Both Access Bandwidth Weight and Storage Efficiency Hint can be left at their 
default settings of 5. These settings produce good volume organizations for each 
redundancy setting that use some, but not for all GigaStorATX’s drive resources. 

If you change the default value for either setting, the number of members chosen 
for the volume depends on the number of drives available at the time the volume is 
created. Small settings tend to use a small number of members. As the setting 
values increase, the number of members will increase slowly. When the values reach 
their maximum, the GigaStorATX will use all possible drives in the volume’s pool and 
the Available Pool for a volume. (The spare count is the only limit to the number of 
drives that can be obtained from the available pool). 

 

 

If you selected None or Mirror for Data Redundancy, the Access and 
Efficiency Settings screen contains only the Access Bandwidth Weight 
setting. 

6. Click the Finish button. The main screen reappears and the volume you created appears 
under Blade A Base Pool in the Logical Resources tab. 

 

 

A plus sign appears next to Blade A Base Pool. Click it to see the volume you 
created. 
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4.1.2 Creating Volumes Manually 

You use the Manual Create Volume Wizard to create volumes manually. The following steps 
describe this procedure. 

1. In the Logical Resources tab, click the plus sign next to Blade A Base Pool. All drives 
available for volume creation appear under Blade A Base Pool. 

2. In the Logical Resources tab, click the plus sign next to Available Pool. All the drives 
attached to the GigaStorATX Storage Controller that do not yet have volumes appear 
under Available Pool. 

3. If drives to be used for this volume are not already in the Blade A Base Pool, those drives 
need to be moved to that Pool. To do this, drag one of the desired drives from Available 
Pool to Blade A Base Pool. Repeat this step for each additional drive that you want 
included in the volume. 

4. In the Logical Resources tab, click Blade A Base Pool. 

5. Perform one of the following steps in the Logical Resources tab: 

– Click the Manual Create Volume button on the toolbar: 

 

– On the Storage menu, click Manual Create Volume. 

The Manual Create Volume Wizard launches and the Select Volume Type to Create 
screen appears (see Figure 4.3). 

 

Figure 4.3. Manual Create Volume Wizard - Select Volume Type to Create Screen 
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6. Complete the fields in the screen: 

– Name. Enter the name of the volume you are creating. 

– Size. Enter the size of the volume you are creating. Use the drop-down box to select 
the volume capacity: 
 

B   =  bytes 

KB =  kilobytes 

MB =  megabytes 

GB =  gigabytes 
 TB =  terabytes 

– Configuration. Select the desired organization: 
 

 

Table 3.2 defines the volume organizations. 

– Chunk Size. Select the size of each chunk from one of the commonly used chunk 
sizes shown:  
 

 

 

 

If you selected JBOD or Mirror as your configuration setting, the Chunk Size 
setting is gray and unavailable. 

 

7. Click the Next button. The Select the Drives screen appears (see Figure 4.4). 
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Figure 4.4. Manual Create Volume Wizard - Select the Drives Screen 

8. In the left box, select the drives from which the volume will be allocated, then click the 
Add button. Observe the following guidelines when selecting drives: 

– JBOD volumes support a minimum of 1 drive and can span across additional drives if 
the capacity required exceeds that which a single drive can provide. 

– Stripe Mirror volumes support an even number of drives, from 4 to 16. 

– Parity volumes support 3 to 16 drives. 

– Mirror and striped volumes support 2 to 16 drives. 

 

 

You can select more than one drive in the left box: 

 To select contiguous drives in the left box, click the first 
drive; then hold down the Shift key and click the last drive. 
All drives between the first and last drives are selected. 

 To select noncontiguous drives in the left box, click the first 
drive; then hold down the Ctrl key and click each additional 
drive you want to select. 

 To remove the selection from a drive in the left box, hold 
down the Ctrl key and click the drive. 

 

 

If you want to remove a drive from the right box, click the drive in the right 
box and click Remove to return the drive to the left box. 

9. Click the Finish button. The main screen reappears and the volume you created appears 
under Blade A Base Pool in the Logical Resources tab. The drives that make up your 
volume appear in the main display. 
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If you select an unacceptable configuration, the Finish button remains gray 
and unavailable until you correct the configuration. Examples of 
unacceptable configurations are selecting an odd number of drives for a 
Stripe Mirror configuration, selecting 1 or 2 drives for a parity volume, and 
selecting 1 drive for a Mirror configuration. 

 

 

If you specify a volume larger than the selected drives can support, an error 
message appears after you click the Finish button. Click OK to remove the 
message, then repeat this procedure and specify a smaller volume. 

4.2 Modifying Volume Configurations 

There may be times when you need to change the configuration settings you specified for a 
volume. To modify a volume’s configuration, use the following procedure. 

1. In the Logical Resources tab, click the volume whose configuration settings you want to 
change. 

2. Perform one of the following steps: 

– On the Storage menu, click Reconfig Volume. 

– Press the right mouse button and click Reconfig Volume. 

Either step starts the Manual Create Volume Wizard and displays the Select Volume Type 
to Create screen (see Figure 4.1). 

3. Review the settings in the displayed screen and change them if necessary. If you need 
help, refer to Section 4.1.2. 

4. Click the Finish button. 

4.3 Expanding a Volume 

There may times when you want to add capacity to a volume. In these cases, you can 
expand a volume to increase to add more physical capacity.  

To expand a volume, use the following procedure. 

1. In the Logical Resources tab, click the volume whose capacity you want to expand. 

2. On the Storage menu, click Expand Volume. The Expand Volume appears (see Figure 
4.5). 
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Figure 4.5. Expand Volume Dialog Box 

3. Use the New Size slide bar to increase the size of the volume. 

4. Click OK. The message in Figure 4.6 appears. 

 

Figure 4.6. Expand Volume Message 

5. Click OK to remove the message. 

 

 

If the selected volume cannot support the size you specified, an error 
message appears. If this occurs, specify a smaller size. 
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4.4 Deleting Volumes 

If you no longer need a volume, use the following procedure to delete it. 

1. In the Logical Resources tab, click the volume you want to delete. 

2. Perform one of the following steps: 

– On the Storage menu, click Delete Volume. 

– Press the right mouse button and click Delete Volume.  

 

Either step displays the message in Figure 4.7. 

 

Figure 4.7. Delete Volume Confirmation Message  

3. Click Yes to delete the volume. (Or click No to keep the volume.) If you clicked Yes, the 
message in Figure 4.8 appears. 

 

Figure 4.8. Successful Volume Deletion Message 

4. Click OK to remove the message. 
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4.5 Performing a Parity Scan on a Volume 

Using the GigaStorATX management console, you can scan a parity volume for errors. This 
task reads every block in the volume looking for errors as described for Media Scan to ensure 
that parity is correct. If parity errors are found, this task corrects the errors. 

To perform a parity scan on a volume, use the following procedure. 

1. Click the volume on which you want to perform the parity scan. 

2. Perform one of the following steps: 

– On the Storage menu, click Parity Scan.  

– Right-click and click Parity Scan 

 

Either step starts the scan operation and displays the message in Figure 4.9. 

 

Figure 4.9. Scan Successfully Started Message 

3. Click OK to remove the message. 

After you start a parity scan task, you can use the Tasks Info screen to view the progress of 
the scan operation (refer to Section 7.2.3.2). 
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4.6 Performing a Media Scan on a Volume 

Using the GigaStorATX management console, you can scan a JBOD, stripe, stripe mirror, or 
stripe mirror media volume for errors. This task reads every block in the volume looking for 
errors as described for Media Scan to ensure that the media is correct. If media errors are 
found, this task corrects the errors. 

To perform a media scan on a volume, use the following procedure. 

1. Click the volume on which you want to perform the media scan. 

2. Perform one of the following steps: 

– On the Storage menu, click Media Scan.  

– Right-click and click Media Scan 

 

Either step starts the scan operation and displays the message in Figure 4.10. 

 

Figure 4.10. Scan Successfully Started Message 

3. Click OK to remove the message. 

After you start a media scan task, you can use the Tasks Info screen to view the progress of 
the scan operation (refer to Section 7.2.3.2). 
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Chapter 5 Working with Initiators, Targets, Network Portals, and 
LAGs 

This chapter describes how to work with iSCSI initiators, iSCSI targets, and network portals. 

Topics in this chapter include: 

 Section 5.1, Adding Initiators on page 54 

 Section 5.2, Working with Network Portal on page 55 

 Section 5.3, Working with LAGS on page 59 

 Section 5.4, Creating iSCSI Target Nodes on page 65 

 Section 5.5, Logging on to the iSCSI Initiator Computer on page 69 
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5.1 Adding Initiators 

The following procedure describes how to add iSCSI initiators. Adding initiators defines what 
initiators have access to the target. You add iSCSI initiators by running the Add Initiator 
Wizard. 

1. Perform one of the following steps in the Logical Resources tab: 

– Click Initiator Resources. Then, on the iSCSI menu, click Add Initiator. 

– Right-click Initiator Resources and click Add Initiator. 

 

Either step starts the Add Initiator Wizard and displays the Create Initiator screen (see 
Figure 5.1). 

 

Figure 5.1. Add Initiator Wizard – Create Initiator Screen 

2. Complete the fields in the screen: 

– Initiator Name. Enter the name of the iSCSI initiator you are creating. 

– Password (optional). To use Challenge Handshake Authentication Protocol (CHAP) 
authentication when connecting to an iSCSI target, type the password that will be 
used during mutual CHAP authentication when an initiator authenticates a target. 
For security, each typed character appears as an asterisk (*). 

– Confirm password. If you typed a password, retype the same one in this field. For 
security, each typed character appears as an asterisk (*). 

3. Click the OK button. The main screen reappears and the iSCSI initiator you created 
appears under Initiator Resources in the Logical Resources tab. 
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If a plus sign appears next to Initiator Resources, click it to see the iSCSI 
initiator you created. 

5.2 Working with Network Portals 

This section describes how to work with network portals. 

5.2.1 Creating a Network Portal 

After you create an iSCSI initiator, you can create a network portal for the LAG. The network 
portal is the physical Ethernet port attached to the host.  

Creating a network portal is a 2-step process: 

1. Ascertain the IP address of the iSCSI initiator. Refer to Section 5.2.1.1. 

2. Assign the IP address to the LAG. Refer to Section 5.2.1.2. 

5.2.1.1 Ascertaining the IP Address of the iSCSI Target 

The following procedure describes how to obtain the IP address of the iSCSI target using the 
Windows Command Prompt window. 

 

 

As an alternative to this procedure, you can use the Microsoft Initiator iSCSI 
software GUI to locate the IP address of the iSCSI target. For more 
information, refer to the documentation that came with Microsoft iSCSI 
initiator software. 

1. Click the Start button, point to Programs, point to Accessories, and click Command 
Prompt. A Command Prompt window opens. 

2. Type ipconfig and press Enter. 

3. Find the IP address of the iSCSI target and write it on a piece of paper (you will need to 
refer to it later in this procedure. 

4. Type exit and press Enter to close the Command Prompt window. 

After you ascertain the IP address of the iSCSI target, you can assign that address to a 
network portal (refer to Section 5.2.1.2). 
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5.2.1.2 Assigning an IP Address to a Network Portal 

After you ascertain the IP address of the ISCSI target, you can assign an IP address to the 
network portal. The network portal and iSCSI target must have different IP addresses, but be 
on the same subnet; that is, the first three octets in their IP addresses must be the same, 
with the last octet being unique. For example, the IP address of the network portal might be 
192.168.1.115, while the IP address of the iSCSI target might be 192.168.1.110.  

To assign an IP address to a network portal, use the following procedure. 

1. In the Logical Resources tab, click the plus sign next to Target Resources. 

2. Click the plus sign next to Network Entities. 

3. Click the plus sign next to LAG Resources.  

4. Under LAG Resources, click a LAG. 

5. Perform one of the following steps: 

– On the Network menu, click Create Network Portal. 

– In the Logical Resources tab, right-click a LAG and click Create Network Port.  

 

Either step starts the Create Network Portal Wizard and displays the Set the IP 
Address screen (see Figure 5.2). 
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Figure 5.2. Create Network Portal Wizard – Set the IP Address Screen 

4. Complete the fields in the screen: 

– IP Address. Enter the IP address for the network portal. The IP address must be 
unique and must be on a different subnet than the management port. However, the 
IP address must be on the same subnet as the iSCSI initiator. For example, if the 
subnet for the iSCSI initiator is 182.148.1.90, you can assign the network portal 
an IP address of 182.148.1.91. In essence, you only need to change the last 
octet (the value following the third period) so it is different than the IP address of 
the iSCSI initiator. 

– Subnet mask. Enter a subnet mask for the network portal or press the Tab key to 
automatically set the default subnet mask to 255.255.255.0. 

5. Click the Finish button. 

5.2.2 Modifying Network Portal Parameters 

There may be times when you need to change the IP address or subnet mask for a network 
portal. To modify a network portal’s configuration settings, use the following procedure. 

1. In the Logical Resources tab, click the network portal whose configuration settings you 
want to change. 

2. Perform one of the following steps: 

– On the Network menu, click Modify Network Portal IP Address. 

– Press the right mouse button and click Modify Network Portal. 

Either step starts the Assign Portals for Target Node Wizard screen (see Figure 5.3). 
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Figure 5.3. Assign Portals for Target Node Wizard Screen 

2. To add network portals, select one or more portals in the left box and click Add to move 
them to the right box. Adding portals defines how the target is accessed. 

3. To remove one or more network portals, select them in the right box and click Remove 
to move it to the left box. 

4. When you finish modifying the network portals, click the Finish button. 

5.2.3 Deleting Network Portals 

If you no longer need a network portal, use the following procedure to delete it. 

 

 

A warning message does not appear before you delete a network portal. 
Therefore, be sure you do not need the network portal before you delete it. 

1. In the Logical Resources tab, click the network portal you want to delete. 

2. Perform one of the following steps to delete the network portal: 

– On the Network menu, click Delete Network Portal. 

– Right-click and click Delete Network Portal. 
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5.3 Working with LAGS 

A LAG is a group of two or more physical network links bundled together to appear as a 
single link. A LAG provides for increased bandwidth and load balancing. The following 
section describes how to create, modify, and delete LAGs. 

5.3.1 Creating LAGs 

By default, the GigaStorATX comes with a maximum of eight LAGs. If you should delete one 
or more LAGs, you can use the following procedure to create LAGs. 

1. In the Logical Resources tab, click the plus sign next to Target Resources. 

2. Click the plus sign next to Network Entities. 

3. Click LAG Resources.  

4. Perform one of the following steps: 

– On the Network menu, click Create LAG. 

– Right-click and click Create LAG. 

 

Either step starts the Create Link Aggregation Group Wizard and displays the LAG 
Parameters screen (see Figure 5.8). 
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Figure 5.4. Create Link Aggregation Group Wizard - LAG Parameters Screen 

5. Complete the fields in the screen: 

– MTU Size. This is a read-only field. 

– Ethernet Encapsulation. Select the Ethernet encapsulation method used to fetch of 
packets from upper-layer protocols, and place header and footer information around 
the data before it traverses the network. The choices are Ethernet CSMA/CD and 
IEEE 802.3ad. 

– VLAN Supported. Check this box if you want the LAG to support a Virtual Network 
(VLAN). 

– Auto Negotiation. This option is unavailable. 

6. Click the Next button. The Add/Delete Ethernet Ports screen appears (see Figure 5.5). 
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Figure 5.5. Create Link Aggregation Group Wizard - Add/Delete Ethernet Ports Screen 

7. To add Ethernet ports, select one or more ports in the left box and click Add to move 
them to the right box. 

8. To remove one or more Ethernet ports, select them in the right box and click Remove to 
move it to the left box. 

9. When you finish adding Ethernet ports, click the Finish button. 

5.3.2 Modifying LAG Parameters 

There may be times when you need to modify LAG parameters. Using the GigaStorATX 
management console, you can view the Maximum Transmission Unit (MTU) size and 
requested speed. 

To modify LAG parameters, use the following procedure. 

1. In the Logical Resources tab, click the LAG whose parameters you want to change. 

2. Perform one of the following steps: 

– On the Network menu, click Modify LAG Parameters. 

– Right-click and click Modify LAG Parameters. 
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– Either step displays the Modify LAG Parameters screen appears (see Figure 5.6). 

 

Figure 5.6. Modify Lag Parameters Dialog Box 

3. Complete the fields in the dialog box: 

– MTU Size. This value specifies the maximum size of a packet that can be transferred 
in one frame over a network. 

– Requested Speed. This value indicates the requested speed for transmitting and 
sending packets. The choices are Auto Detect, 100 Mbps, and 10 Mbps. 

4. Click OK. 
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5.3.3 Configuring Physical Ports 

To configure physical ports, use the following procedure. 

1. In the Logical Resources tab, click a LAG whose physical port you want to configure. 

2. On the Network menu, click Config Physical Port. The Add/Remove Ethernet Ports for 
LAG Wizard starts and the Add/Delete Ethernet Ports screen appears (see Figure 5.7). 

 

Figure 5.7. Add/Remove Ethernet Ports for LAG Wizard - Add/Delete Ethernet Ports screen 

3. To add Ethernet ports, select one or more ports in the left box and click Add to move 
them to the right box. 

4. To remove one or more Ethernet ports, select them in the right box and click Remove to 
move it to the left box. 

5. When you finish adding Ethernet ports, click the Finish button. 
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5.3.4 Deleting LAGs 

If you no longer need a LAG, use the following procedure to delete it. 

 

 

A warning message does not appear before you delete a LAG. Therefore, be 
sure you do not need the LAG before you delete it. 

1. In the Logical Resources tab, click the LAG you want to delete. 

2. Perform one of the following steps: 

– On the Storage menu, click Delete LAG. 

– Right-click and click Delete LAG. 

 

Either step deletes the selected LAG. 
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5.4 Creating iSCSI Target Nodes 

After you create one or more volumes, iSCSI initiators, and LAGs, you have all the 
prerequisites to create an iSCSI target node.  

To create an iSCSI target node, use the following procedure. 

1. In the Logical Resources tab, click Target Resources or Network Entities. 

2. Perform one of the following steps: 

– On the iSCSI menu, click Create iSCSI Target Node. 

– Right-click and click Create iSCSI Target Node. 

 

Either step starts the Create iSCSI Node Wizard and displays the Enter iSCSI Node 
Information screen (see Figure 5.8). 

 

Figure 5.8. Create iSCSI Node Wizard - Enter iSCSI Node Information Screen 

3. Complete the fields in the screen: 

– iSCSI Node Alias (optional). An alias string can also be associated with an iSCSI node. 
The alias lets an organization associate a user-friendly string with the iSCSI name. 

– Enable CHAP Secret (optional). To use CHAP authentication when connecting to an 
iSCSI target, check this box to enable the CHAP secret. Then, in the CHAP Secret 
field (see Figure 5.9), type the password that will be used by the target to 
authenticate an initiator. 
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The CHAP secret is case sensitive. For security, each typed character in the 
CHAP secret appears as an asterisk (*). If you decide not to specify a CHAP 
secret now, you can do so in the future using the Set CHAP Secret command 
in the iSCSI menu (refer to Section 6.14). 

 

Figure 5.9. Create iSCSI Node Wizard - Enter iSCSI Node Information Screen with CHAP Secret Field Shown 

4. Click Next. The Configure iSCSI Node Parameters screen appears (see Figure 5.10). 

 

Figure 5.10. Create iSCSI Node Wizard - Configure iSCSI Node Parameters Screen 
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5. Accept the default settings in the Session Settings and Connection Settings tabs and 
click Next. The Initiators List screen appears (see Figure 5.11). 

 

Figure 5.11. Create iSCSI Node Wizard – Initiator List Screen 

6. The left box lists all the iSCSI initiators you have defined. Click the iSCSI initiator(s) in 
this list that are allowed to access the volumes through the target network portals 
whose IP addresses you selected in the previous screen. 

7. Click Add to move the selected iSCSI initiator(s) to the right box. 

 

 

If you want to remove an iSCSI initiator from the right box, click the iSCSI 
initiator in the right box and click Remove to return the iSCSI initiator to the 
left box. 

8. Click Next. The Volume Access Right screen appears (see Figure 5.12). 
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Figure 5.12. Create iSCSI Node Wizard – Volume Access Right Screen 

9. The left box lists all the volumes you have created. Click a volume in this list, then click 
Add to move the selected volume to the right box. 

 

 

You can select more than one volume in the left box: 

 To select contiguous volumes in the left box, click the first 
volume; then hold down the Shift key and click the last 
volume. All volumes between the first and last volumes are 
selected. 

 To select noncontiguous volumes in the left box, click the 
first volume; then hold down the Ctrl key and click each 
additional volume you want to select. 

 To remove the selection from a volume in the left box, hold 
down the Ctrl key and click the volume. 

 

 

If you want to remove a volume from the right box, click the volume in the 
right box and click Remove to return the volume to the left box. 

 

10. Click Finish. 
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5.5 Logging on to the iSCSI Initiator Computer 

After you create a volume (Section 4.1), create an iSCSI initiator (Section 5.1), create a 
network portal (Section 5.2), and create iSCSI target nodes (Section 5), use the following 
procedure to log on to the Microsoft iSCSI initiator. 

1. Connect the appropriate GigaStorATX Storage Controller Ethernet port to the NIC in the 
iSCSI initiator computer using an Ethernet RJ-45 cable. 

2. Start the Microsoft iSCSI initiator application: 

– Click the Start button. 

– Point to Programs. 

– Point to Microsoft iSCSI Initiator. 

– Click Microsoft iSCSI Initiator. 

When Microsoft iSCSI Initiator starts, the iSCSI Initiator Properties dialog box appears. 

3. Click the Discovery tab. 

4. Click Add to add a target portal. The Add Target Portal dialog box appears. 

5. If your iSCSI target node is registered in a DNS that the iSCSI initiator computer can 
access, enter the DNS name of the computer. If not, enter the IP address of the target 
network portal that this iSCSI initiator will use to access the requested volumes.  

6. Click OK. The IP address you entered (192.168.1.115 in the example in Figure 5.13) 
appears in the Discovery tab. 

 

Figure 5.13. Discovery Tab on the iSCSI Initiator Properties Dialog Box 
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6. Click the Targets tab (see Figure 5.14). Notice that the iSCSI initiator software lists the 
target node name. It found this name after you entered the IP address or DNS name of 
the iSCSI target node. 

 

Figure 5.14. Targets Tab on the iSCSI Initiator Properties Dialog Box 

7. Click Log On to display the Log On To Target dialog box (see Figure 5.15). 

 

Figure 5.15. Log on to Target Dialog Box 

8. To connect to the iSCSI target node, click OK. Tab over to the Active Sessions page to 
assure that you are connected to the iSCSI target node.  

If desired, click Programs > Administrative Tools > Computer Management and verify that 
the disk you have configured is shown in the Computer Management screen. In Figure 5.16, 
Disk 2 was added through the GigaStorATX management console. You can also right-click 
over the new drive and click Create Partition from the right-click menu to create a partition 
on the drive. For more information, refer to your Windows documentation. Tim? 
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Figure 5.16. Example of Disks Shown in the Computer Management Screen 
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Chapter 6 Performing Additional Activities 

This chapter describes how to perform various console activities. 

Topics in this chapter include: 

 Section 6.1, Managing User Accounts on page 74 

 Section 6.2, Changing the GigaStorATX Date and Time on page 76 

 Section 6.3, Enabling or Disabling SSL on page 78 

 Section 6.4, Changing the iSCSI Port Number on page 79 

 Section 6.5, Setting the Default Task Priority on page 80 

 Section 6.6, Performing Cache Activities on page 81 

 Section 6.7, Managing GigaStorATX Configurations on page 83 

 Section 6.8, Modifying System TCP/IP Settings on page 86 

 Section 6.9, Setting the Spare Count on page 88 

 Section 6.10, Setting the System Battery Policy on page 89 

 Section 6.11, Restarting the GigaStorATX on page 91 

 Section 6.12, Creating Scheduled Tasks on page 92 

 Section 6.13, Adding, Viewing, and Deleting IP Route Table on page 94 

 Section 6.14, Changing the CHAP Secret on page 96 
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6.1 Managing User Accounts 

A user account must be set up for each user who wants to access the GigaStorATX 
management console. The user account consists of the following: 

 A unique user name and password. 

 Determine whether a user can manage storage and/or add or edit user accounts. 

Initially, the GigaStorATX comes with a single user account called admin. By default, the 
admin user has permission to manage storage and add and edit user accounts. The admin 
account cannot be deleted. 

When the admin user sets up a user account, he can specify whether the other user accounts 
can also manage storage and add/edit user accounts. These two permissions operate 
independently, so the admin could, for example: 

 Permit a user account to manage storage, without being able to add or edit user 
accounts. 

 Permit a user account to add or edit other user accounts, without being able to manage 
storage. 

 Prevent a user account from managing storage and adding and editing user accounts. 
With this setting, the user can only view information on the GigaStorATX management 
console screens. The user would not be able to change any settings on the screens. 

6.1.1 Setting Up User Accounts 

To set up user accounts, use the following procedure. 

1. Be sure the Physical Resources tab is the active tab. 

2. On the View menu, click User Accounts. The User Accounts screen appears, with a list 
of the user accounts that have been defined (see Figure 6.1). 

 

Figure 6.1. User Accounts Screen 

3. Click the Add User button. The Add New User dialog box appears (see Figure 6.2). 
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Figure 6.2. Add New User Dialog Box 

3. Complete the fields in the dialog box: 

– Username. Enter the name of the user whose account you are creating. 

– Password. Enter the password for this user account. This is the case-sensitive 
password the user must specify when logging in to the GigaStorATX management 
console. 

– Confirm password. Retype the same case-sensitive password you typed in the 
Password field. 

 

 

For security, each typed character in Password and Confirm password 
appears as an asterisk (*). 

– Allow to manage storage. Check  this option if you want this user to be able to 
manage storage on the GigaStorATX. 

– Allow to manage user accounts. Check this option if you want this user to be able 
to define and modify user accounts.  

 

 

If you do not check Allow to manage storage and Allow to manage user 
accounts, the user will be able to view the GigaStorATX management 
console screens, but will not be able to change storage settings or 
add/modify user accounts. 

4. Click OK. The user you defined appears in the User Accounts screen. 

5. Click the Close button to exit the User Accounts screen. 
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6.1.2 Deleting User Accounts 

If you no longer need a user account, use the following procedure to delete it. 

1. On the View menu, click User Accounts. The User Accounts screen appears, with a list 
of the user accounts that have been defined (see Figure 6.1 on page 74). 

2. Click the user whose account you want to delete, then click the Delete User button.  

3. When a precautionary message asks whether you want to delete the user account, click 
Yes. The selected user account is deleted from the Use Accounts screen. 

6.2 Changing the GigaStorATX Date and Time 

The GigaStorATX Storage Controller maintains the current timezone, date and time. If you 
need to change these settings, use the following procedure. This procedure requires you to 
reset the GigaStorATX Storage Controller. 

1. Click the GigaStorATX icon at the top of the Physical Resources tab. 

2. Perform one of the following steps: 

– On the File menu, click GigaStor Date and Time.  

– Right-click and click GigaStor Date and Time. 

 

Either step displays the GigaStor Date and Time dialog box, with the system timezone, 
date, and time settings shown (see Figure 6.3). 
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Figure 6.3. GigaStor Date and Time Dialog Box 

3. Complete the fields in the dialog box: 

– Timezone. Select the appropriate timezone form the drop-down list. 

– System Date. Either use the controls to the right of this field to select the 
appropriate system date or click the calendar icon and select a date from the popup 
calendar. 

– System Time. Use the controls to the right of this field to select the appropriate 
system time. 

4. Click OK. A message asks whether you want to restart the system (see Figure 6.4). 

 

Figure 6.4. Restart System Message 

5. Click Yes to restart the system or No to not restart it. You must restart the GigaStorATX 
Storage Controller for the revised timezone, date, and time to take effect. 
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6.3 Enabling or Disabling SSL 

Secure Sockets Layer (SSL) is the encryption process that allows a user's communication with 
a Web server to be secured, so that others cannot intercept and decipher any of the data 
being transferred. Using the GigaStorATX management console, you can enable or disable 
SSL between the management port and the PC connected to it. 

To enable or disable SSL, use the following procedure. 

1. Click the GigaStorATX icon at the top of the Physical Resources tab. 

2. Perform one of the following steps: 

– On the File menu, click Enable SSL.  

– Right-click and click Enable SSL. 

 

Either step displays the Enable/Disable SSL dialog box, with the current SSL setting 
shown (see Figure 6.5). 

 

Figure 6.5. Enable/Disable SSL Dialog Box 

2. To enable SSL, click Enable SSL so a check mark appears next to it. To disable SSL, click 
Enable SSL to remove the check mark next to it. 

3. Click OK. 
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6.4 Changing the iSCSI Port Number 

The iSCSI port number is the TCP/IP port number on which the iSCSI target is listening. The 
standard port number for iSCSI is 3260, but some targets may allow the port number to be 
customized. To change the iSCSI port number, use the following procedure. 

1. Click the GigaStorATX icon at the top of the Physical Resources tab. 

2. Perform one of the following steps: 

– On the File menu, click Change iSCSI Port Number.  

– Right-click and click Change iSCSI Port Number. 

 

Either step displays the Modify iSCSI Port dialog box, with the current iSCSI port number 
shown (see Figure 6.6). 

 

Figure 6.6. Modify iSCSI Port Dialog Box 

2. Enter a new value for the iSCSI port. 

3. Click OK. 
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6.5 Setting the Default Task Priority 

You can set the default task priority to specify whether background tasks receive a high or 
low priority. By default, the default task priority provides for minimum impact on the 
foreground applications performed by the GigaStorATX. However, you can change this 
setting if desired. For example, you may want to specify a higher default task priority for 
time-critical tasks such as backups.  

 

 

Assigning a high task priority can increase system I/O and, as a result, lose 
its effectiveness. If the GigaStorATX performs one task that is critical while 
the rest of the tasks are normal priority, you can use this procedure to raise 
the priority of the task temporarily, then reduce it after the time-critical 
task has completed. 

To set the default task priority, use the following procedure. 

1. On the File menu, click Set Default Task Priority. The Set Default Task Priority dialog 
box appears, with the current setting shown (see Figure 6.7). 

 

Figure 6.7. Set Default Task Priority Dialog Box 

2. Use the slider switch to specify the default priority level (0 = lowest priority, 10 = 
highest priority). 

3. Click OK. 
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6.6 Performing Cache Activities 

The GigaStorATX Storage Controller contains cache memory for storing I/O activity and data. 
The File menu provides options for setting the cache mode and flushing cache contents. 

6.6.1 Setting Cache Mode 

The GigaStorATX Storage Controller is capable of caching write operations. Write-back 
caching saves the system from performing many unnecessary write cycles to the system RAM, 
which can lead to noticeably faster execution. However, when write-back caching is used, 
writes to cached memory locations are only placed in cache and the data is not written to 
the disks until the cache is flushed. When caching is disabled, all read and write operations 
directly access the physical disks. 

To set cache mode, use the following procedure. 

1. On the File menu, click Set Cache Mode. The Set Cache Mode dialog box appears, with 
the current setting shown (see Figure 6.8). 

 

Figure 6.8. Set Cache Mode Dialog Box 

2. To enable write backs to system cache, click Write back so a check mark appears next 
to it. To disable write backs to system cache, click Write back to remove the check 
mark next to it. 

3. Click OK. 

 

 

If you enable Write back, be sure the battery policy is not set to Stop 
buffering I/O in cache, and directly write data to disk (refer to Section 
6.10). 
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6.6.2 Flushing Cache 

Flushing cache writes the contents of cache memory to the physical disks. This safety 
measure prevents the accumulation of data in cache that could be lost in the event of a 
power loss. 

To flush cache, use the following procedure. 

1. Click the GigaStorATX icon at the top of the Physical Resources tab. 

2. Perform one of the following steps: 

– On the File menu, click Flush Cache. 

– Right-click and click Flush Cache. 

 

Either step displays the Set Cache Mode dialog box, with the current setting shown (see 
Figure 6.8). 

 

Figure 6.9. Set Cache Mode Dialog Box 

4. To enable write backs to system cache, click Write back so a check mark appears next 
to it. To disable write backs to system cache, click Write back to remove the check 
mark next to it. 

5. Click OK. 
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6.7 Managing GigaStorATX Configurations 

The GigaStorATX management console provides options for saving and restoring the 
GigaStorATX configuration. You can also return the GigaStorATX to is factory default settings. 

6.7.1 Saving the GigaStorATX Configuration 

To save the current GigaStorATX configuration, use the following procedure. 

1. On the File menu, click Save GigaStor Configuration. The Save GigaStor Configuration 
dialog box appears (see Figure 6.10). 

 

Figure 6.10. Save GigaStor Dialog Box 

2. Navigate to the location where you want to save the configuration. 

3. IN the File name field, type a name for the configuration. 

4. Click the Save button. 
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6.7.2 Restoring the GigaStorATX Configuration 

If you used the procedure in Section 6.7.1 to save the GigaStorATX configuration, you can 
use the following procedure to restore the saved configuration. 

1. On the File menu, click Restore GigaStor Configuration. The Restore GigaStor 
Configuration dialog box appears (see Figure 6.11). 

 

Figure 6.11. Restore GigaStor Configuration Dialog Box 

2. Locate the configuration file whose settings you want to load, then select the file and 
click the Open button. The message in Figure 6.12 appears. 

 

Figure 6.12. Configuration Restore Message 

3. Click Yes to restore the configuration. (Or click No to keep the current configuration.) If 
you clicked Yes the GigaStorATX Storage Controller restarts and loads the selected 
configuration. 
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6.7.3 Restoring Factory Defaults 

To return the GigaStorATX to its factory default settings, use the following procedure. 

 

 

When you return to the factory default settings, the GigaStorATX IP port 
reverts to 192.168.1.1. 

 

1. On the File menu, click Restore Factory Defaults. The message in Figure 6.13 appears. 

 

Figure 6.13. Restore Factory Defaults Message 

2. Click Yes to restore the factory defaults. (Or click No to keep the current configuration.) 
If you clicked Yes the GigaStorATX Storage Controller loads the factory default settings 
and the message in Figure 6.14 appears. 

 

Figure 6.14. Restore to Factory Defaults Succeeded Message 

3. Click OK to restart the GigaStorATX Storage Controller with the factory default settings. 
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6.8 Modifying System TCP/IP Settings 

You can use the GigaStorATX management console to view and change the system’s TCP/IP 
settings. 

To modify the system TCP/IP settings, use the following procedure. 

1. Click the GigaStorATX icon at the top of the Physical Resources tab. 

2. Perform one of the following steps: 

– On the File menu, click Modify System TCP/IP Settings.  

– Right-click and click Modify System TCP/IP Settings. 

 

Either step displays the Modify System TCP/IP Settings dialog box appears, with the 
current setting shown (see Figure 6.15).  

 

Figure 6.15. Modify System TCP/IP Settings Dialog Box 
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3. Complete the fields in the dialog box: 

– Max Segment Size. This option indicates the maximum size TCP segment that can be 
accepted on a TCP/IP connection when the connection is established. 

– Window Scale. This option lets you use large windows during TCP/IP connections. 
On fast, high-bandwidth networks, a large TCP window provides greater efficiency 
by allowing for a greater amount of unacknowledged data. 

– TCP Timestamp Enabled. This option causes the receiving computer to send a time-
stamp reply back to the originating computer. Systems can use time-stamp requests 
and replies to measure the transmission speed of datagrams on a network. 

– Time to Live (TTL). This option specifies the default time to live (TTL) value for IP 
packets generated by the Windows TCP/IP stack. 

– PMTU Enabled. Enabling this option allows the GigaStorATX to automatically adapt 
its packet size. Disabling this option makes the system keep its default packet size 
(576 bytes), even when it receives an ICMP request asking it to change its packet 
size. Disabling this option can render some remote systems unreachable, because if 
intermediate systems on the path to the remote system cannot support the default 
packet size, the GigaStorATX will ignore their requests to make the packets smaller. 

– Upper Layer Counter Reset. This option resets the TCP/IP upper layer counters. 
Resetting the counters simplifies the ability to look at the counters for an accurate 
percentage of packets sent or received. 

4. Click OK. 
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6.9 Setting the Spare Count 

You can specify the number of spares available to the GigaStorATX Storage Controller. A 
spare is a drive that is present in the system but normally unused until another drive fails, at 
which time the hot spare is automatically substituted for the failed drive. For more 
information about the spare count, refer to Section 3.4. 

To set the spare count, use the following procedure. 

1. Click the GigaStorATX icon at the top of the Physical Resources tab. 

2. Perform one of the following steps: 

– On the File menu, click Set Spare Count.  

– Right-click and click Set Spare Count. 

 

Either step displays the Set Spare Count dialog box appears, with the current setting 
shown (see Figure 6.16). 

 

Figure 6.16. Set Spare Count Dialog Box 

3. Enter a value that corresponds to the number of drives. 

4. Click OK. 
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6.10 Setting the System Battery Policy 

The GigaStorATX Storage Controller has a battery that must be fully charged before RAID 
operations can be performed. Using the GigaStorATX management console, you can specify a 
battery policy that defines the action that the GigaStorATX Storage Controller is to perform 
if the battery fails. 

To set the system battery policy, use the following procedure. 

1. Click the GigaStorATX icon at the top of the Physical Resources tab. 

2. Perform one of the following steps: 

– On the File menu, click Set System Battery Policy.  

– Right-click and click Set System Battery Policy. 

 

Either step displays the Battery Policy dialog box appears, with the current setting 
shown (see Figure 6.17). The traffic light at the top of the dialog box provides a color-
coded indication of the GigaStorATX battery status. 
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Figure 6.17. Battery Policy Dialog Box 

3. Select the appropriate setting that the GigaStorATX Storage Controller should use if the 
battery fails. The choices are: 

– Ignore the status of the battery and do nothing. Use this setting if you will be 
operating the GigaStorATX from AC power with an uninterruptible power supply. 

– Stop buffering I/O in cache, and directly write data to disk. Use this setting if you 
want to write to disk all I/O buffered in cache memory in the event of a battery 
failure. 

 

 

If the GigaStorATX is operating from battery and the battery fails, there may 
not be sufficient time to write all the buffered I/O to disk. This can result In 
lost or unintelligible data. 

– Prevent any reads from or writes to volumes. This setting prevents all read and 
write operations form occurring if the battery fails.  

4. Click OK. 
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6.11 Restarting the GigaStorATX 

To restart the GigaStorATX Storage Controller, use the following procedure. 

1. Log off from all iSCSI initiators. 

2. Click the GigaStorATX icon at the top of the Physical Resources tab. 

3. Perform one of the following steps: 

– On the File menu, click Restart System. 

– Right-click and click Restart System. 

 

Either step displays a message that asks whether you are sure you want to restart the 
system. 

4. Click Yes to restart the system (or click No to keep the system running). If you clicked 
Yes, your management console session ends and the GigaStorATX Storage Controller is 
restarted. You can then use the log in procedure in Section 2.2 to log into the 
GigaStorATX management console. 
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6.12 Creating Scheduled Tasks 

You can use the GigaStorATX management console to set up tasks that you want the Storage 
Controller to perform, such as performing parity or media scans. When you create a task, 
you can specify the day and time when the task is to be performed and whether the task will 
repeat (recur). 

To create tasks, use the following procedure. 

1. On the View menu, click Create Task. The Scheduled Task Wizard launches and the 
Volume and Operation screen appears (see Figure 6.18). 

 

Figure 6.18. Scheduled Task Wizard – Volume and Operation 

2. Complete the fields in the screen: 

– Operation Name. Enter a name for the task you are creating. 

– Object. Select the volume on which the scheduled task will be performed. 

– Operation. Select the task that is to be performed. 

– Perform this task. Select how often the scheduled task is to be performed. 

3. Click Next. The Select Date and Time screen appears (see Figure 6.19). 
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Figure 6.19. Scheduled Task Wizard – Select Date and Time Screen 

4. Complete the fields in the screen: 

– Start time. Use the controls to specify the time when the scheduled task is to start. 

– Start date. Use the calendar to select the date when the scheduled task is to start. 
You can use the controls below the calendar to move to the previous year, previous 
month, next month, or next year. 

5. Click Finish. 

After you schedule a task, you can use the Tasks Info screen to view the task status (refer to 
Section 7.2.3.2). 
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6.13 Adding, Viewing, and Deleting IP Route Tables 

Routing is the process of deciding the disposition of each incoming and outbound packet that 
the GigaStorATX Storage Controller handles. Using the GigaStorATX management console, 
you can view the GigaStorATX Storage Controller’s routing table.  

If a route being used encounters problems, you can use the GigaStorATX management 
console to add route tables. Adding a route is also useful if you discover a quick alternative 
route to the destination. You can also use the GigaStorATX management console to delete 
routes. 

To add, view, and delete IP route tables, use the following procedure. 

1. On the View menu, click View Manual Route. The View Route Table appears, with the 
current route tables shown (see Figure 6.20). 

 

Figure 6.20. View Route Table 

2. To add a route to the routing table, click the Add button. Then, when the dialog box in 
Figure 6.21 appears, complete the fields and click OK. 

– Destination. Enter the IP address of the destination for this route. 

– Netmask. Enter the netmask associated with this route or press the Tab key to 
automatically set the default subnet mask to 255.255.255.0. 

– Gateway. If the route uses a gateway, specify the gateway associated with this 
route. 



 

 GigaStorATX User Functional Guide 95 

 

Figure 6.21. Adding a Route Table 

3. To delete a route, click the route in the View Route Table and click the Delete button. 

 

 

A warning message does not appear before you delete a route. Therefore, be 
sure you do not need the route before you delete it. 
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6.14 Changing the CHAP Secret 

When you created an iSCSI target node, you could specify an optional CHAP secret. If desired, 
you can change the CHAP secret using the following procedure. 

1. Click a network entity (prefaced by naa) in the Logical Resources tab. 

2. On the iSCSI menu, click Change CHAP Secret. The Set CHAP Secret dialog box appears 
(see Figure 6.22). 

 

Figure 6.22. Set CHAP Secret Dialog Box 

3. Complete the fields in the dialog box: 

– CHAP Secret. Enter the CHAP secret. 

– Confirm CHAP Secret. Enter the same CHAP secret. 

 

 

The CHAP secret is case sensitive. For security, each typed character in 
CHAP Secret and Confirm CHAP Secret appears as an asterisk (*). 

4. Click OK. 
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6.15 Saving the Event Log 

The event log tracks the GigaStorATX informational, warning, and error messages (refer to 
Section 7.1.2). Using the GigaStorATX management console, you can save the event log as an 
unformatted text file to a user-specified folder.  

To save the event log, use the following procedure. 

1. On the View menu, click Save Event Log Messages. The Open dialog box appears (see 
Figure 6.23). 

 

Figure 6.23. Open Dialog Box 

2. Using the Open dialog box, navigate to the location where you want the event log text 
file to reside. 

3. In the File name field, enter a name for the event log text file. 

4. Click OK. 
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Chapter 7 Viewing GigaStorATX Screens 

The GigaStorATX management console can display a number of screens in the main area for 
viewing system and storage information. This chapter shows and describes the screens. Some 
screens are available from either the Logical Resources or Physical Resources tab. Other 
screens are available from both tabs. 

 GigaStor Screens (Physical Resources tabs) 

– Viewing enclosure information — refer to Section 7.1.1. 

– Viewing log messages — refer to Section 7.1.2. 

– Viewing information about tasks — refer to Section 7.1.3. 

– Viewing CIM server information — refer to Section 7.1.4. 

– Viewing firmware image information — refer to Section 7.1.5. 

 Blade A Base Pool Screens (Logical Resources tab) 

– Viewing information about the storage pool — refer to Section 7.2.1. 

– Viewing information about tasks — refer to Section 7.2.2. 

– Viewing information about volumes — refer to Section 7.2.3. 

– Viewing information about drives — refer to Section 7.2.4. 

 Network Entities Screens (Logical Resources tab) 

– Viewing information about iSCSI target nodes — refer to Section 7.3.1. 

– Viewing volume access information — refer to Section 7.3.2. 

– Viewing iSCSI initiator access information — refer to Section 7.3.3. 

– Viewing information about network portals — refer to Section 7.3.4. 

– Viewing information about LAG ports — refer to Section 7.3.5. 

– Viewing information about an iSCSI connection — refer to Section 7.4. 

 Initiator Resource Screens (Logical Resources tab) 

– Viewing information about iSCSI initiators — refer to Section 7.4.1. 

– Viewing LUN access information — refer to Section 7.4.2. 

 Drive Screens (Physical Resources tab) 

– Viewing information about drives — refer to Section 7.2.4. 

 Ethernet Port Screens (Physical Resources tab) 

– Viewing information about Ethernet ports — refer to Section 7.5. 
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7.1 GigaStor Screens 

When the top GigaStorATX icon is selected in the Physical Resources tab, the main display 
area can show the following screens with information about:  

 The GigaStorATX Storage Controller enclosure. Refer to Section 7.1.1. 

 Log messages. Refer to Section 7.1.2. 

 Tasks information. Refer to Section 7.1.3. 

 CIM Server information. Refer to Section 7.1.4. 

 Firmware image information. Refer to Section 7.1.5. 

7.1.1 Viewing Enclosure Information 

When the top GigaStorATX icon is selected in the Physical Resources tab, you can use the 
Enclosure Information screen to view information about the GigaStorATX enclosure (see 
Figure 7.1).  

This screen is divided into three areas: 

 Message Log Summary. The Message Log Summary summarizes the current error, 
warning, and information messages in the event log. To enhance visibility, the three 
message types are color coded.  

– Error messages are red and indicate something unexpected has occurred that may be 
a serious problem. 

– Warning messages are yellow. Warning messages indicate that something appeared 
wrong but has been corrected. They also provide notification about things that may 
be expected but are of particular interest. 

– Informational messages are green. Informational messages contain information about 
steps performed, detected version information, and miscellaneous messages. 

For more information about a message, go to the Log Messages screen (refer to Section 
7.1.2). 

 System Settings. The Systems Settings show the spare count, disk line mode, and 
default BT priority settings.  

 TCP/IP Default Parameters. The TCP/IP Default Parameters show the maximum IP 
segmentation, TCP window scale, TCP timestamp, and PMTU enabled settings.  
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Figure 7.1. Enclosure Information Screen 
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7.1.2 Viewing Log Messages 

When the top GigaStorATX icon is selected in the Physical Resources tab, you can use the 
Log Messages screen to view the entries in the event log (see Figure 7.2).  

 

Figure 7.2. Log Messages Screen 

The messages are color coded, making it easy to differentiate among informational, warning, 
and error messages. The messages are time- and date-stamped, with the most recent entry 
appearing at the top of the screen. 

To obtain additional information about a message shown in the Log Messages screen, double-
click the message. A Log Message Details box appears, with detailed information about the 
message (see Figure 7.3). The box also provides buttons for moving to the next or previous 
message in the message log and an OK button for exiting.  

 

 

You can save the event log entries as an unformatted text file to disk. For 
more information, refer to Section 6.15. 
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Figure 7.3. Example of a Log Messages Details Box 

You can save the Log Messages as an unformatted text file to a user-specified folder. For 
more information, refer to Section 6.14. 
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7.1.3 Viewing GigaStorATX Tasks 

When the top GigaStorATX icon is selected in the Physical Resources tab, you can use the 
Tasks Info screen to view the GigaStorATX tasks (see Figure 7.4). Examples of tasks include 
bad block scan and volume initialization activities.  

Each row of the Tasks Info screen corresponds to a task. The last column, Recurring, shows 
whether the task is recurring and will repeat again in the future. 

 

Figure 7.4. Tasks Info Screen 

To obtain additional information about a task shown in the Tasks Info screen, double-click 
the task. A Task Message Details box appears, with detailed information about the task (see 
Figure 7.5). 
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Figure 7.5. Example of a Task Message Details Box 

If you right-click a task in the Tasks Info screen, a popup similar to the one in Figure 7.6 
appears. Depending on the options that are available, you can:  

 Set a priority for the selected task. 

 Suspend or resume the task. 

 Cancel the task to stop the current task from being performed. If the task is recurring, it 
will start again automatically when scheduled. 

 Delete the task. 
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Figure 7.6. Task Popup Menu 
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7.1.4 Viewing Server CIM Information 

When the top GigaStorATX icon is selected in the Physical Resources tab, you can use the 
CIM Server Info screen to view Storage Management Initiative (SMI) server and profile 
information (see Figure 7.7). The SMI Server Information area has an Edit button you can 
click to change the SMI server information if necessary.  

 

Figure 7.7. CIM Server Info Screen 
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7.1.5 Viewing Firmware Image Information 

When the top GigaStorATX icon is selected in the Physical Resources tab, you can use the 
Firmware Image Info screen to view the currently active firmware image being used by the 
GigaStorATX Storage Controller (see Figure 7.8). This screen also shows other valid firmware 
images that have been used with the GigaStorATX.  

 

 

For information about upgrading the GigaStorATX Storage Controller 
firmware, refer to Appendix B. 

 

 

Figure 7.8. Firmware Image Info Screen 
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7.2 Blade A Base Pool Screens 

When Blade A Base Pool is selected in the Logical Resources tab, the main display area can 
show the following screens with information about the storage pool:  

 Storage group information. Refer to Section 7.2.1. 

 Tasks information. Refer to Section 7.2.2. 

You can also display the following screens by clicking the appropriate entity below Blade A 
Base Pool: 

 Volumes. Lets you view information about the volumes that make up the storage pool. 
Refer to Section 7.2.3. 

 Drives. Lets you view information about the drives that make up the storage pool. Refer 
to Section 7.2.4. 
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7.2.1 Viewing Information about the Storage Pool 

When Blade A Base Pool is selected in the Logical Resources tab, you can use the Storage 
Group Information screen to view information about the storage pool (see Figure 7.9).  

The top-left side of the screen shows the storage pool type, amount of free space, total 
capacity, and number of drives. To the right of this information is a pie chart that provides a 
graphical representation of the amount of used and unused (free) space in the storage pool. 
Used space is shown in gray and unused space is shown in green. 

Below this information are rows that correspond to the drives attached to the GigaStorATX 
Storage Controller. Each row corresponds to a separate drive and shows the drive’s: 

 Slot number 

 State (online, offline, etc.). For readability, the state is color coded (green = online, 
black = offline. 

 Capacity 

 Utilization percentage 

 Allocation 

 

Figure 7.9. Storage Group Information 
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7.2.2 Viewing Storage Pool Tasks 

When Blade A Base Pool is selected in the Logical Resources tab, you can use the Tasks Info 
screen to view tasks scheduled for the storage pool (see Figure 7.10). Examples of tasks 
include media scan and drive initialization activities.  

Each row of the Tasks Info screen corresponds to a task. The last column, Recurring, shows 
whether the task is recurring and will repeat again in the future. 

 

Figure 7.10. Tasks Info Screen 
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To obtain additional information about a task shown in the Tasks Info screen, double-click 
the task. A Task Message Details box appears, with detailed information about the task (see 
Figure 7.13).  

 

Figure 7.11. Example of a Task Message Details Box 
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7.2.3 Viewing Information about Volumes in the Blade A Base Pool 

When a volume is selected under Blade A Base Pool in the Logical Resources tab, two 
screens are available in the main display:  

 Volume information screen. Refer to Section 7.2.3.1. 

 Tasks Info screen. Refer to Section 7.2.3.2. 
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7.2.3.1 Viewing Volume Information about a Volume 

When you click a volume under Blade A Base Pool, you can use the Volume Information 
screen to view information about the selected volume.  

 

 

The name of the volume appears in the tab. Figure 7.12, for example, shows 
information for a volume named “Zeus.” 

The Volume Information screen shows the following information (see Figure 7.12): 

 The volume’s durable name and size, volume status and cache status, volume type, 
storage efficiency and storage bandwidth, and chunk size. 

 A graphical representation of the drives associated with the volume. 

 A LUN Map that shows the iSCSI target node(s), LUN Number(s), and Access Mode(s). 

 

Figure 7.12. Example of Volume Information for a Volume Named Zeus 
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7.2.3.2 Viewing Volume Tasks 

When you click a volume under Blade A Base Pool, you can use the Task Info screen to view 
tasks assigned to the selected volume. 

Each row of the Tasks Info screen corresponds to a task assigned to the volume. The 
information shown for each task is (see Figure 7.13): 

 The task name 

 The object (volume) assigned the task 

 The task (operation) that is to be performed 

 The progress of the task 

 The status of the task 

 The task’s estimated completion time (ECT) 

 Whether the task is recurring 

 

Figure 7.13. Tasks Info Screen 
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To obtain additional information about a task shown in the Tasks Info screen, double-click 
the task. A Task Message Details box appears, with detailed information about the task (see 
Figure 7.14)  

 

Figure 7.14. Example of the Task Message Details Dialog Box 
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7.2.4 Viewing Information about Drives in the Blade A Base Pool 

When a drive is selected under Blade A Base Pool in the Logical Resources or when a drive 
is selected on the Physical Resources tab, you can view information about the selected 
drive (see Figure 7.15). This screen shows the following information about the selected drive:  

 Drive number 

 Vendor model 

 Physical capacity 

 State (for example, online or offline) 

 Microcode level 

 

Figure 7.15. Drive Information Screen 
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7.3  Network Entities Screens 

When a network entity is selected in the Logical Resources tab, the main display area can 
show the following screens with information about the selected network entity:  

 Type Node Info. Refer to Section 7.3.1. 

 Volume Access Info. Refer to Section 7.3.2. 

 Initiator Access Info. Refer to Section 7.3.3. 

 Portals Info. Refer to Section 7.3.4. 

7.3.1 Viewing Target Node Information 

When a network entity is selected in the Logical Resources tab, you can use the Target 
Node Info screen to view the session and connection parameters associated with the 
selected network entity.  

 

Figure 7.16. Target Node Info Screen 
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7.3.2 Viewing Volume Access Information 

When a network entity is selected in the Logical Resources tab, you can use the Volume 
Access Info screen to view LUN Map information for the volume associated with the selected 
network entity.  

 

Figure 7.17. Volume Access Info Screen 
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7.3.3 Viewing Initiator Access Information 

When a network entity is selected in the Logical Resources tab, you can use the Initiator 
Access Info screen to view iSCSI initiator and access information associated with the selected 
network entity.  

 

Figure 7.18. Initiator Access Info Screen 
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7.3.4 Viewing Network Portal Information 

When a network entity is selected in the Logical Resources tab, you can use the Portals Info 
screen to view the IP address and port number associated with the selected network entity.  

 

Figure 7.19. Portals Info Screen 
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7.3.5 Viewing LAG Port Information 

When a LAG is selected in the Logical Resources tab, the main display shows the LAG Port 
Info tab (see Figure 7.20). This tab is divided into the following sections:  

 LAG port information. This section shows the following information: 

– LAG MAC port address 

– Requested per-port speed 

– Aggregate LAG speed 

– Link status 

– Admin status 

– Ethernet encapsulation 

– VLAN support 

– Auto negotiation 

– MTU 

 Ethernet Port. This area shows the status of each Ethernet port associated with the LAG 
port. To enhance viewing, online ports are shown in green.  

 IP Address. This area shows the IP addresses and corresponding VLAN IDs, if any, 
associated with the LAG port.  

 

Figure 7.20. Example of a LAG Port Info Screen 
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7.3.6 Viewing Connection Information 

If you select a connection in the Physical Resources tab, the main display shows the 
connection parameters and session information for the selected connection (see Figure 7.21).  

 

Figure 7.21. Connection Information Screen 
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7.4 Initiator Resource Screens 

When a network entity is selected in the Logical Resources tab, the main display area can 
show the following tabs with information about the selected iSCSI initiator: 

 Initiator Info. Refer to Section 7.4.1. 

 LUN Access Info. Refer to Section 7.4.2. 

7.4.1 Viewing  Initiator Information 

When an iSCSI initiator is selected in the Logical Resources tab, you can use the Initiator 
Information screen to view information associated with the selected iSCSI initiator (see 
Figure 7.22).  

 

Figure 7.22. Initiator Information Screen 
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7.4.2 Viewing  LUN Map Information 

When an iSCSI initiator is selected in the Logical Resources tab, you can use the LUN Map 
Information screen to view LUN Map information associated with the selected iSCSI initiator 
(see Figure 7.23).  

 

Figure 7.23. LUN Map Information Screen 
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7.5 Viewing Ethernet Port Information 

When an Ethernet port is selected in the Physical Resources tab, the main display area 
shows the physical port information for the selected Ethernet port (see Figure 7.24).  

 

Figure 7.24. Physical Port Information 
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Appendix A Summary of Menus and Commands 

This appendix summarizes the menus and commands available in the GigaStorATX 
management console. 

A.1 File Menu  

The File menu contains the following commands.  

 

Command Description 

Shutdown System Lets you shut down the GigaStorATX management 
console and Storage Controller. 

Restart System Lets you reboot the GigaStorATX management 
console and Storage Controller. 

Attempt to Bind Reserved for future use. 

GigaStor Date and Time Lets you change the system date and time. 

Enable SSL Lets you enable/disable Secure Sockets Layer. 

Set OID and Inquiry Data Lets you set the organization unique identifier of 
the connection or session.  

Configure Out of Band Port Lets you change the GigaStorATX IP address, 
subnet mask, hostname, and gateway settings. 

Change iSCSI Port Number Lets you change the iSCSI port number for the  

Set Default Task Priority Lets you set the priority of tasks. 

Set Cache Mode Lets you enable cache on the GigaStorATX 
Storage Controller cache memory. 

Flush Cache Lets you remove information stored in cache. 

Configure ISNS Client Reserved for future use. 

Save GigaStor Configuration Lets you save the GigaStorATX configuration. 

Restore GigaStor Configuration Lets you restore the GigaStorATX configuration. 

Restore Factory Defaults Lets you return the unit to its factory default 
settings. 

Configure System iSNS Reserved for future use. 

Modify System TCP/IP Settings Lets you change the system TCP/IP settings. 

Set Spare Count Lets you specify the number of spares available to 
the GigaStorATX. 

Configure Disk Line Reserved for future use. 

Set System Battery Policy Lets you specify the action that the GigaStorATX is 
to follow if the battery fails. 

 

Exit Lets you exit the GigaStorATX management 
console. 
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A.2 View Menu 

The View menu contains the following commands.  

 

Command Description 

User Accounts Lets you set up, modify, and delete user 
accounts. 

Create Task Lets you define tasks that the GigaStorATX is to 
perform. Tasks defined here can be viewed on 
the Tasks Info screen. 

Firmware Upgrade Lets you upgrade the GigaStorATX Storage 
Controller firmware. 

View Manual Route Lets you view the manual route. 

 

Save Event Log Messages Lets you save the event log as an unformatted 
text file to a user-specified folder. 
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A.3 Storage Menu 

The Storage menu contains the following commands.  

 

Command Description 

Create Volume Lets you create a new volume. 

Reconfig Volume Lets you change the settings for a selected 
volume. 

Delete Volume Lets you delete a volume. 

Parity Scan Lets you perform a party scan on the selected 
drives. 

Expand Volume Lets you increase the capacity of a selected 
volume. 

Rebuild Volume Reserved for future use. 

Initialize Drive Lets you initialize a selected drive. 

Make Spare Reserved for future use. 

Down Drive Reserved for future use. 

Identify Drive Reserved for future use. 

Manual Create Volume Lets you create a volume manually. 

 

Media Scan Lets you perform a media scan on a selected 
drive. 

 



 

130 Appendix A Summary of Menus and Commands 

A.4 Network Menu 

The Network menu contains the following commands.  

 

Command Description 

Create Network Portal Lets you create a network portal. 

Delete Network Portal Lets you delete a network portal. 

Create LAG Lets you create a LAG. 

Delete LAG Lets you delete a LAG, 

Modify LAG Parameters Lets you change the settings for a 
selected LAG. 

Reset Statistics Reserved for future use. 

Modify Network Portal IP Address Lets you modify a network portal IP 
address. 

Config Physical Port Lets you configure a selected 
physical port. 

 

View Manual Route Lets you view the manual route. 

A.5 iSCSI Menu 

The iSCSI menu contains the following commands.  

 

Command Description 

Add Initiator Lets you add an iSCSI initiator. 

Delete Initiator Lets you delete an iSCSI initiator. 

Set CHAP Secret Lets you specify a CHAP secret. 

Rename Alias Reserved for future use. 

Create iSCSI Target Node Lets you create an iSCSI node. 

Delete Target Node Lets you delete an iSCSI target 
node. 

Modify Target Node Parameters Lets you change the settings for a 
selected iSCSI target. 

Modify Initiator List Lets you change the entries in the 
iSCSI initiator list. 

Modify Volume Access Mode Lets you change the settings for a 
selected volume. 

 

Modify Network Portal Lets you change the settings for a 
selected network portal. 
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A.6 Help Menu 

The Help menu contains the following commands.  

 

Command Description 

Help Lets you access the GigaStorATX online help. 

 About Shows the GigaStorATX management console version 
number. A System Properties tab lets you view system 
properties. 
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Appendix B Upgrading Firmware 

This appendix describes how to upgrade the firmware in the GigaStorATX Storage Controller 
using the GigaStorATX management console.  

1. Go to the GIGA-BYTE FTP site and download the appropriate firmware file. 

 

 

On a piece of paper, write the location and folder where you download the 
firmware file. You will need to access this location later in this procedure. 

2. On the View menu, click Firmware Upgrade. The message in B-1 appears. 

 

Figure B-1. Firmware Upgrade Message 

3. Click OK to continue. (Or click Cancel to exit without upgrading the firmware.) If you 
click OK, the Open dialog box appears (see Figure B-2). 

 

Figure B-2. Example of the Open Dialog Box 

4. Navigate to the location where the firmware file you downloaded from the GIGA-BYTE 
FTP site is located. 
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5. Click the firmware file, then click the Open button. (Or as a shortcut, double-click the 
firmware file). The new firmware is installed. A progress bar shows the status of the 
installation. 

6. After the firmware is installed, a message prompts you to press OK to restart the 
GigaStorATX Storage Controller to have the new firmware take effect. 

7. Click OK to restart the GigaStorATX Storage Controller. If additional messages appear, 
click OK to remove them. 

8. After the GigaStorATX Storage Controller restarts, launch your Web browser again and 
log in to the GigaStorATX management console. 

 

 

The Firmware Image Info screen shows the current active firmware image 
being used by the GigaStorATX Storage Controller. For more information, 
refer to Section 7.1.5. 
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Appendix C Acronyms and Abbreviations 
Administrator The person responsible for managing storage operations. The administrator 

is the user who will use the storage management console provided with the 
GigaStorATX Storage Controller. 

CHAP Challenge Handshake Authentication Protocol. CHAP is a protocol for 
authenticating the peer of a connection and is based upon the peers sharing 
a secret (a security key similar to a password). 

CSMA/CD Carrier Sense Multiple Access/Collision Detection.) The LAN access method 
used in Ethernet. When a device wants to gain access to the network, it 
checks whether the network is quiet (senses the carrier). If it is not, it waits 
a random amount of time before retrying. If the network is quiet and two 
devices access the line at exactly the same time, their signals collide. When 
the collision is detected, they both back off and each waits a random 
amount of time before retrying. 

Drive A physical storage drive (usually, but not necessarily, a disk drive) managed 
by the GigaStorATX system. 

802.3 An IEEE standard for a CSMA/CD local-area network access method, which is 
used in Ethernet, the most common LAN technology. 

Extent A contiguous set of LBs on a drive. An extent is also called a physical extent. 

Initiator node An iSCSI node that performs as an iSCSI Initiator in accessing data stored on 
the GigaStor system. 

LAG Link Aggregation Group. The combining of physical network links into a 
single logical link for increased bandwidth. A LAG increases capacity and 
availability of the communications channel between devices using existing 
Fast Ethernet and Gigabit Ethernet technology. LAGs also provide load 
balancing, where processing and communications activity is distributed 
across several links in a trunk, so that no single link is overwhelmed.  

LB Logical Block. A block of storage stored (and read) by the system. 

LUN Logical Unit Number. According to the SCSI Architectural Model, the number 
used by an iSCSI initiator to access a target’s Logical Unit. In the 
GigaStorATX Storage Controller, a logical unit is a volume. 

Member A group of chunks organized vertically in an array. 

Mirror A method for improving reliability of a Volume by providing data 
redundancy. In a mirror volume, data redundancy is provided by recoding 
every data block on more than one drive. 

MPU Management Processor Unit. The PowerPC CPU used for management 
processing on the GigaStorATX Storage Controller. 
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Parity A way to improve reliability of a volume by providing data redundancy. In a 
parity volume, data redundancy is improved by recording data blocks across 
multiple drives and recording one additional parity block on an additional 
drive. If any single drive fails, the original data can be reconstructed from 
the remaining blocks. 

PLBN Physical Logical Block Number. The number of an LB on a drive. 

Striping A way to improve I/O performance on a volume by splitting data among 
multiple drives. 

Storage pool A collection of drives used as a group for common functions (for example, 
the space used by a volume must be allocated from a specific storage pool). 

Subnet A portion of a network that shares a common address component. On 
TCP/IP networks, subnets are defined as all devices whose IP addresses have 
the same prefix. For example, all devices with IP addresses that start with 
100.100.100. are part of the same subnet. 

VLBN Virtual Logical Block Number. The number of an LB within a volume. The LB 
is used to store customer data. 

Volume A fixed amount of storage on a disk. The term volume is often used as a 
synonym for the storage medium itself, but it is possible for a single disk to 
contain more than one volume or for a volume to span more than one disk. 
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Index 
A 

Accounts · 72 
Activities 

cache · 79 
CHAP secret · 94 
date and time · 74 
default task priority · 78 
flushing cache · 80 
IP route tables · 92 
iSCSI 

port number · 77 
modifying system TCP/IP settings · 84 
restarting the GigaStorATX · 89 
restoring GigaStorATX configuration · 82 
saving GigaStorATX configuration · 81 
saving the event log · 95 
scheduled tasks · 90 
setting cache mode · 79 
setting the battery policy · 87 
setting the spare count · 86 
SSL · 76 
user accounts · 72 

Adding initiators · 52 
Automatically creating volumes · 38 

B 
Battery policy, setting · 87 
Blade A Base Pool screens · 107 

C 
Cache 

flushing · 80 
setting the mode · 79 

Changing the default IP address · 25 
CHAP secret · 94 
Configuration 

restoring · 82 
restoring factory defaults · 83 
roadmap · 14 
saving · 81 

Configuring physical ports · 61 
Connection Information screen · 121 
Contact information · vi 
Conventions · v 
Creating 

iSCSI target nodes · 63 
LAGs · 57 
network portals · 53 

Creating scheduled tasks · 90 
Creating volumes 

automatically · 38 

manually · 42 

D 
Date and time · 74 
Default IP address, changing · 25 
Default task priority · 78 
Deleting 

LAGs · 62 
network portals · 56 
user accounts · 74 
volumes · 47 

Drive Information screen · 115 
Drives, overview · 31 

E 
Enclosure Information screen · 98 
Ethernet Port · 120 
Event log 

details · 100 
saving · 95 

Expanding volumes · 34 
procedure · 45 

F 
Factory defaults, restoring · 83 
File menu · 125 
Firmware 

image information · 106 
upgrading · 131 

Firmware Image Info screen · 106 
Flushing cache · 80 
Footer · 24 

G 
GigaStor screens · 98 
GigaStorATX 

restarting · 89 
GigaStorATX 

date and time · 74 
managing configurations · 81 
restoring configurations · 82 
restoring factory defaults · 83 
saving configuration · 81 
shutting down · 27 

GigaStorATX 
viewing tasks · 102 

H 
Help menu · 129 

I 
Initializing a volume · 34 
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Initiator Access Info screen · 118 
Initiator information · 122 
Initiator Information screen · 122 
Initiators, adding · 52 
Internal structure of volumes · 32 
IP address 

and VLAN IDs · 120 
changing · 25 
iSCSI target · 53 
network portal · 54 

IP route tables · 92 
iSCSI 

menu · 128 
port number · 77 
target node creation · 63 

iSCSI initiator, logging on · 67 
iSCSI target, ascertaining the IP address · 53 

J 
JBOD · 32 

L 
LAG Port Info screen · 120 
LAG port information · 120 
LAGs 

creating · 57 
deleting · 62 
modifying parameters · 59 

Launching the management console · 17 
Log Message Details · 100 
Log Messages screen · 100 
Logging on to iSCSI initiator · 67 
LUN Map Information screen · 123 

M 
Main display area · 22 
Main screen · 19 

footer · 24 
main display area · 22 
menu / tool bar area · 20 
resource pane · 21 

Management console 
changing the default IP address · 25 
description · 14 
launching · 17 
main screen · 19 
shutting down · 26 
user accounts · 19 

Managing GigaStorATX configurations · 81 
Manually creating volumes · 42 
Media scan 

overview · 34 
procedure · 49 

Menu / toolbar area · 20 

Menus 
File · 125 
Help · 129 
iSCSI · 128 
Network · 128 
Storage · 127 
View · 126 

Message Log Summary · 98 
Mirror · 32 
Modifying 

LAG parameters · 59 
network portal parameters · 55 
system TCP/IP settings · 84 
volume configurations · 45 

N 
Network Entities screens · 116 
Network menu · 128 
Network portals 

assigning an IP address · 54 
creating · 53 
deleting · 56 
modifying parameters · 55 

P 
Parity · 32 
Parity scan 

overview · 35 
procedure · 48 

Physical Port Information screen · 124 
Physical ports, configuring · 61 
Portals Info screen · 119 

R 
Rebuilding a volume · 34 
Resource pane · 21 
Restarting the GigaStorATX · 89 
Restoring 

factory defaults · 83 
GigaStorATX configurations · 82 

S 
Saving 

event log · 95 
GigaStorATX configuration · 81 

Scheduled tasks · 90 
Screens 

Blade A Base Pool · 107 
Connection Information · 121 
Drive Information · 115 
enclosure information · 98 
Firmware Image Info · 106 
GigaStor · 98 
Initiator Access Info · 118 
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Initiator Information · 122 
LAG Port Info · 120 
LUN Map Information · 123 
Network Entities · 116 
Physical Port Information · 124 
Portals Info · 119 
Server CIM Info · 105 
Storage Group Information · 108 
Target Node Info · 116 
Tasks Info, GigaStorATX · 102 
Tasks Info, storage pools · 109 
Tasks Info, volumes · 113 
Volume Access Info · 117 
volume information · 112 

Server CIM Info screen · 105 
Setting 

battery policy · 87 
cache mode · 79 
spare count · 86 
user accounts · 72 

Shutting down the GigaStorATX · 27 
Shutting down the GigaStorATX management 

console · 26 
Spare count · 34 

setting · 86 
SSL · 76 
Storage Group Information screen · 108 
Storage menu · 127 
Storage pools · 29, 31 
Stripe · 32 
Stripe mirror · 32 
Structure of volumes · 32 
System TCP/IP settings, modifying · 84 
Systems Settings · 98 

T 
Target Node Info screen · 116 
Task message details 

GigaStorATX · 103 
storage pools · 110 
volumes · 114 

Tasks 
creating · 90 
default priority · 78 
expanding a volume · 34 
initializing a volume · 34 
media scan · 34 
overview · 34 
parity scan · 35 
rebuilding a volume · 34 

Tasks Info screen 
GigaStorATX · 102 
storage pools · 109 
volumes · 113 

TCP/IP Default Parameters · 98 
Time and date · 74 
Typographic conventions · v 

U 
Upgrading firmware · 131 
User accounts · 19 

deleting · 74 
setting up · 72 

User accounts · 72 

V 
View menu · 126 
Viewing 

connection information · 121 
drive information · 115 
firmware image information · 106 
GigaStorATX tasks · 102 
initiator access information · 118 
initiator information · 122 
LAG port information · 120 
log messages · 100 
LUN map information · 123 
message log summary · 98 
physical port information · 124 
portal information · 119 
Server CIM information · 105 
storage group information · 108 
storage pool tasks · 109 
system settings · 98 
target node drive information · 116 
TCP/IP default parameters · 98 
volume access information · 117 
volume information · 112 
volume tasks · 113 

VLAN IDs · 120 
Volume Access Info screen · 117 
Volume Information screen · 112 
Volumes 

creating automatically · 38 
creating manually · 42 
deleting · 47 
expanding · 45 
internal structure · 32 
media scan · 49 
modifying configurations · 45 
organizing · 32 
overview · 31 
parity scan · 48 
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